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 Laras Titi Nawang Wulan, 2021. “ Analisis Optimasi Waktu Dan Biaya 

Dengan Penambahan Jam Kerja (Lembur) Menggunakan Metode Time Cost 

Trade Off “. Pada perencanaan awal suatu proyek kontruksi, faktor waktu, 

biaya dan kualitas membentuk hubungan yang saling tergantungan sera 

berpengaruh sangat kuat. Permasalahan penelitian ini yang didapat dari Time 

Schedule ada pada minggu ke 3 yang mengalami penurunan pada pekerjaan 

aspal dengan waktu 6 hari karena menunggu pekerjaan struktur yang memakan 

waktu lama dikarenakan faktor cuaca. Penelitian ini bertujuan untuk 

mengetahui waktu dan biaya optimal penyelesaian proyek setelah dilakukan 

penambahan jam kerja (lembur) dan perbandingan waktu dan biaya optimum 

setelah dilakukan penambahan jam kerja (lembur). Penelitian ini dilakukan 

dengan metode time cost trade off dengan penambahan jam kerja (lembur) 

pada pekerjaan tenaga kerja. Metode ini dilakukan dengan menambah jam 

kerja (lembur) selama 1 jam, 2 jam dan 3 jam dengan menggunakan alat 

program Microsoft Project 2013. Hasil pada program menggunakan Microsoft 

Project 2013 yaitu lintas kritis dan kenaikan biaya akibat dari penambahan jam 

kerja (lembur) sedangkan dari metode time cost trade off yaitu percepatan 

durasi dan kenaikan biaya akibat dari percepatan durasi dalam setiap kegiatan 

yang dipercepat. Pada proyek Peningkatan Jalan Kalingsa Wetan – Randusanga 

Wetan Kabupaten Brebes. Dari hasil penelitian waktu normal pada proyek 

yaitu 45 hari dengan total biaya sebesar Rp. 1.482.125.000 waktu dan biaya 

optimum akibat penambahan jam kerja lembur 1 jam didapatkan dursi proyek 

38 hari dengan total biaya sebesar Rp. 1.210.527.713. untuk penambahan jam 

kerja lembur 2 jam didapatkan durasi proyek 38 hari dengan total biaya sebesar 

Rp. 1.211.101.803 sedangkan untuk penambahan jam kerja lembur 3 jam 

didapatkan durasi proyek 38 hari dengan total biaya sebesar Rp. 1.211.577.304. 

Kesimpulan dari ketiga tersebut alternatif penambahan jam kerja lembur biaya 

termurah ialah dengan penambahan lembur 1 jam dengan durasi proyek 38 hari 

dan total biaya proyek Rp. 1.210.527.713. 

 

 

Kata Kunci: Waktu, Biaya, Metode Time Cost Trade Off,  Jam Lembur, 

Tenaga Kerja, Microsoft Project 2013 
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  Laras Titi Nawang Wulan, 2021. "Analysis of Time and Cost Optimization 

With Additional Working Hours (Overtime) Using the Time Cost Trade Off 

Method". In the initial planning of a construction project, the time, cost and 

quality factors form an interdependent relationship and have a very strong 

influence. The problem in this research, which was obtained from the Time 

Schedule, was in the 3rd week which experienced a decrease in asphalt work 

with 6 days due to waiting for structural work which took a long time due to 

weather factors. This study aims to determine the optimal time and cost of 

project completion after additional working hours (overtime) and the 

comparison of the optimum time and cost after additional working hours 

(overtime). This research was conducted using the time cost trade off method 

with the addition of working hours (overtime) on the work of the workforce. 

This method is done by adding working hours (overtime) for 1 hour, 2 hours 

and 3 hours using the Microsoft Project 2013 program tool. The results of the 

program using Microsoft Project 2013 are critical cross and increased costs due 

to additional working hours (overtime). The time cost trade off method is the 

acceleration of the duration and the increase in costs resulting from the 

acceleration of the duration in each accelerated activity. In the Kalingsa Wetan 

– Randusanga Wetan Road Improvement project, Brebes Regency. From the 

research results, the normal time for the project is 45 days with a total cost of 

Rp. 1,482,125,000 optimum time and cost due to the addition of 1 hour of 

overtime work, the project duration is 38 days with a total cost of Rp. 

1,210,527,713. for the addition of 2 hours of overtime work, the project 

duration is 38 days with a total cost of Rp. 1,211,101,803 while for the addition 

of 3 hours of overtime work, the project duration is 38 days with a total cost of 

Rp. 1,211,577,304. The conclusion of the three alternative working hours of 

overtime the cheapest cost is to add 1 hour of overtime with a project duration 

of 38 days and a total project cost of Rp. 1,210,527,713. 

 

 

Keywords: Time, Cost, Time Cost Trade Off Method, Overtime, Labor, 

Microsoft Project 2013. 
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BAB I 

PENDAHULUAN 

 

A. Latar Belakang Masalah  

Dikutip dari jurnal Firdaus, (2013) Jalan adalah prasarana 

transportasi darat yang meliputi segala bagian jalan, termasuk bangunan 

perlengkapan dan perlengkapannya yang diperuntukankan bagi lalu lintas, 

yang berada pada permukaan tanah, diatas permukaan tanah, di bawah 

permukaan tanah dan/atau air, serta di atas permukaan air, kecuali jalan 

kereta api, jalan lori dan jalan kabel. (Peraturan Pemerintah Nomer 34 

Tahun, 2006). Dikutip dari jurnal Norman, (2018) Pada perencanaan awal 

suatu proyek kontruksi, faktor waktu, biaya dan kualitas membentuk 

hubungan yang saling tergantungan serta berpengaruh sangat kuat, oleh 

karena itu percepatan penyelesaian proyek pun harus dilakukan 

perencanaan dengan baik dan benar. Dengan memanfaatkan waktu yang 

optimal maka alternatif yang digunakan untuk menunjang percepatan 

aktivitas yaitu dengan menambah kerja atau memperlakukan jam kerja 

lembur. Untuk mengetahui maka perlu dipelajari tentang jaringan kerja 

yang ada, hubungan antara waktu dan biaya yang dimaksud adalah 

Analisis pertukaran waktu dan biaya (Time Cost Trade Off Analyisi) 

(Frederika, 2010). Di kutip dari jurnal Vebiola et al., (2020) proyek 

umumnya memiliki batas waktu (deadline), artinya proyek harus 

diselesaikan sebelum atau tepat waktu yang ditentukan. Berkaitan dengan 
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Masalah pada proyek maka keberhasilan pelaksanaan sebuah proyek, tepat 

pada waktunya merupakan tujuan yang penting baik bagi pemilik proyek 

maupun kontraktor. Aktivitas dalam suatu proyek bermacam – macam, 

mulai dari peralatan yang dibutuhkan, sumber daya yang ditugaskan dan 

berbagai metode pelaksanaan yang diterapkan sehingga dapat diperkirakan 

durasi dan biaya untuk menyelesaikan setiap aktivitasnya. Apabila ada hal 

itu maka pihak dari kontraktor sebagai pelaksana dilapangan harus dengan 

cekatan dalam memberikan solusi atas keterlambatan tersebut misalnya 

dengan melakukan percepatan. Percepatan dilakukan tidak hanya untuk 

mengatasi masalah keterlambatan. Apabila ada ada permintaan secara 

khusus dari owner untuk mempercepat proyek maka bisa digunakan dengan 

percepatan tersebut juga bisa diterapkan di proyek (Kisworo et al., 2017). 

Dikutip dari jurnal Vebiola et al., (2020) Metode Time Cost Trade Off yaitu 

metode yang dapat digunakan atau diaplikasikan untuk mempercepat waktu, 

pelaksanaan proyek dan menganalisa waktu yang dapat dipersingkat dengan 

adanya penambahan biaya terhadap kegiatan, yang bisa dipercepat waktu 

pelaksanaanya sehingga dapat diketahui percepatan yang paling maksimum, 

dan biaya yang paling minimum (Izzah, 2017).  

Dikutip dari profil Kabupaten Brebes menurut Sekadau et al., (2019) 

Kabupaten Brebes memiliki luas wilayah sebesar 176.346,27 Ha. 

Kabupaten Brebes terbagi atas 17 Kecamatan dan 297 Desa atau 

Kelurahan. Termasuk Desa Kaligangsa Wetan dan Randusanga Wetan 

yang terdapat proyek Peningkatan Jalan yang menghubungkan Kaligangsa 
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Wetan – Randusanga Wetan, Proyek ini dibangun pada taggal 10 

November – 24 November 2020 dan lokasinya di Jalan Parintis 

Kemerdekaan Desa Kaligangsa Wetan, Kabupaten Brebes, Jawa Tengah. 

Pemilik proyek ini adalah Pemerintah Kabupaten Brebes Dinas Pekerjaan 

Umum Dan Penataan Ruang, Jalan Kaligangsa Wetan – Randusanga 

Wetan memiliki Panjang 630 Meter dan Lebar 4 Meter dengan 

menghabiskan biaya sebesar Rp. 1.482.125.000,00. di dalam proyek 

Peningkatan Jalan Kaligangsa Wetan- Randusanga Wetan yang dikerjakan 

oleh CV. Mulya Jaya sebagai Kontraktor dan CV. Papan Desain sebagai 

Konsultan Pengawas.  

Dalam penelitian sebelumnya yang dilakukan oleh Kisworo et al., 

(2017) Pada pembangunan Jalan Tol Semarang- Solo Ruas Bawen-Solo 

Seksi II. Tujuan dari penelitian adalah untuk mempercepat waktu 

pelaksanaan proyek dengan penambahan biaya minimum, menganalisis 

sejauh mana waktu dapat dipersingkat dengan penambahan biaya 

minimum dan membandingkan alternatif percepatan yang lebih efisien 

untuk dilaksanakan. Pada penelitian ini pada proses crashing tahap ke-28 

dengan penambahan biaya kerja lembur didapat biaya efisiensi sebesar 

0,29% dengan waktu penyelesaian proyek 191 hari dan efisiensi waktu 

sebesar 22,0408% dan alternatif penambahan kapasitas alat menghasilkan 

waktu optimal 212 hari dengan efisiensi waktu sebesar 0,015% dengan 

efisiensi biaya sebesar 13,4694% pada proses crashing. Menurut penelitian 

Hendriyani et al., (2020) Proyek Peningkatan Jalan Bina Bakti Kelurahan 
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Gunung Seteleng Kabupaten Pasar Utara mengalami keterlambatan, salah 

satu upaya mengoptimalkan proyek tersebut dengan cara metode Time 

Cost Trade Off ini digunakan untuk menghitung perubahan waktu dan 

biaya pelaksanaan proyek paling optimum, dengan penambahan jam kerja 

lembur dan penambahan tenaga kerja. Berdasarkan hasil penelitian waktu 

dan biaya paling optimum setelah penambahan kerja lembur durasi 

crashing 42,4 hari dengan efisiensi biaya 0,11% dan efisiensi waktu 

13,47% dan untuk penambahan tenaga kerja didapat durasi crashing 37,8 

hari dengan efisiensi biaya 0,54% dan waktu 22,86%. Dari data survey 

lapangan yang di dapat dari data Time Schedule terdapat permasalahan 

pada minggu ke 3 yang mengalami penurunan pada pekerjaan aspal 

dengan waktu pekerjaan 6 hari, Total biaya pekerjan Rp 22.101.917,25 

yaitu ada 3 pekerjaan yang pertama pekerjaan lapisan resap pengikat (aspal 

cair/emulsi) dengan perlambatan waktu 17,53% ,kedua pekerjaan lapisan 

perekat (aspal cair/emulsi) dengan perlambatan waktu 17,8% , dan ketiga 

pekerjaan lapis penetrasi macadam dengan perlambatan waktu 16,81% 

karena pada pekerjaan tersebut menunggu pekerjaan struktur yang 

memakan waktu lama dikarenakan faktor cuaca. 

Dari hasil survey lapangan terdapat permasalahan mengenai 

perlambatan waktu dan perbedaan antara artikel jurnal penelitian yang 

saya gunakan sebagai referensi. penelitian dilakukan pada proyek 

pembangunan Jalan Kaligangsa Wetan – Randusanga Wetan dengan 

menggunakan Metode Time Cost Trade Off. Dengan data yang sudah 
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didapatkan, dilakukan analisis untuk mendapatkan waktu yang sedikit 

dengan biaya minimum. Oleh karena itu dilakukan penelitian ini untuk 

mengetahui durasi waktu dan biaya yang optimal dalam penyelesaian 

proyek dengan dilakukan perbandingan terhadap penambahan jam kerja 

(lembur) dengan metode Time Cost Trade Off  alat yang bervariasi dari 1 

jam lembur sampai 3 jam lembur dengan menggunakan program Microsoft 

Project 2013. 

B. Batasan Masalah  

Agar penulisan dapat lebih fokus dan terarah, Proyek yang 

ditinjau adalah Proyek Peningkatan Jalan Kaligangsa Wetan – 

Randusanga Wetan. Adapun batasan masalah yang ditinjau meliputi : 

1. Pengambilan data dilakukan pada proyek peningkatan Jalan 

Kaligangsa – Randusanga Wetan Kabupaten Brebes. 

2. Percepatan proyek hanya dilakukan dengan penambahan jam kerja 

(lembur). 

3. Metode yang digunakan adalah metode pertukaran waktu dan biaya 

(Time Cost Trade Off Method). 

4. Jam kerja efektif yang ditinjau yaitu jam kerja normal dengan waktu 

7 jam/hari, yaitu hari kerja senin- minggu dengan jam kerja kisaran 

08.00-16.00 WIB dengan waktu jam istirahat 12.00-13.00 WIB dan 

maksimum jam lembur yang diperkenakan selama 3 jam dari jam 

16.00-19.00 WIB. 

5. Penambahan jam kerja (lembur) yaitu : 1 jam , 2 jam dan 3 jam  
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6. Pengoptimasi waktu dan biaya dengan metode penambahan jam kerja 

(lembur) menggunakan program Microsoft Project 2013. 

7. Anggaran biaya dan jadwal pekerjaan diambil sesuai dengan data 

yang ada pada RAB dan Time Schedule. 

C. Rumusan Masalah  

1. Berapakah waktu yang dapat dipersingkat dalam penyelesaian suatu 

pekerjaan proyek setelah dilakukan percepatan dengan penambahan 

jam kerja (lembur) dengan Metode Time Cost Trade Off  ? 

2. Berapakah selisih biaya perbandingan setelah dilakukan penambahan 

jam kerja (lembur) dengan Metode Time Cost Trade Off  ? 

D. Tujuan Penelitian  

1. Untuk mengetahui waktu dan biaya optimal penyelesaian proyek 

setelah dilakukan penambahan jam kerja (lembur) dan dilakukan 

percepatan. 

2. Untuk mengetahui perbandingan waktu dan biaya optimum setelah 

dilakukan penambahan jam kerja (lembur). 

E. Manfaat Penelitian  

1. Dapat memberikan informasi atau masukan kepada owner,kontaktor 

maupun konsultan mengenai percepatan waktu dan biaya yang dapat 

mengeoptimalkan pekerjaan. 

2. Mengetahui waktu dan biaya optimum proyek setelah dilakukan 

penambahan jam kerja (lembur) sebagai acuan pekerjaan proyek yang 
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sama serta menggunakan analisa pertukaran waktu dan biaya  dengan 

(Time Cost Trade Off Analysis) dan Microsoft Project 2013. 

F. Sistematika Penulisan Skripsi 

Secara garis besar, Penelitian ini akan disusun dalam tiga bab dengan 

sistematika sebagai berikut : 

BAB I.  PENDAHULUAN  

  Bab ini menguraikan tentang latar belakang masalah 

mengenai pokok pikiran penelitian dan secara umum. 

Perbandingan dengan penelitian sebelumnya, kemudian 

dilanjutkan perumusan masalah yang diangkat tersebut 

serta dikemukaan dengan batasan masalah, tujuan 

penelitian, manfaat penelitian serta penulisan sistematika 

yang digunakan. 

BAB II.  LANDASAN TEORI DAN TINJAUAN PUSTAKA 

  Bab ini menguraikan tentang landasan teori tantang 

penelitian yang diambil serta berbagai referensi yang 

mendukung demi tercapainya tujuan penelitian ini dan 

berisi teori-teori dasar yang berhubungan dengan judul 

penulisan. 

BAB III.  METODE PENELITIAN  

  Bab ini menguraikan metodologi yang digunakan dalam 

penyelesaian masalah penelitian dengan berdasarkan 
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waktu dan biaya kemudian dilanjutkan dengan analisis 

menggunakan metode Time Cost Trade Off dengan 

penambahan jam kerja (lembur) dan menggunakan 

aplikasi Microsoft Project 2013. Metode pengumpulan 

data, pengolahan data dan analisis data kemudian tahapan 

penelitian. 

BAB IV HASIL PENELITIAN DAN PEMBAHASAN  

  Bab ini berisi tentang hasil dari data yang diolah 

menggunakan aplikasi Microsoft Project 2013, yang 

dilanjutkan dengan penambahan jam kerja (lembur) 

sehingga memperoleh hasil perbandingan waktu dan biaya 

semula.  

BAB V  KESIMPULAN DAN SARAN  

 Bab ini berisi kesimpulan penulis akan hasil dari penelitian 

yang diambil dan saran untuk penelitian lebih lanjut. 

DAFTAR PUSTAKA 

LAMPIRAN 
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BAB II 

LANDASAN TEORI DAN TINJAUAN PUSTAKA 

A. LANDASAN TEORI 

1. Proyek Konstruksi  

Dikutip dari penelitian Norman, (2018) Proyek yaitu sekumpulan 

aktivitas yang saling berhubungan dimana ada titik awal dan titik akhir 

serta hasil tertentu, proyek biasanya bersifat lintas fungsi organisasi 

sehingga membutuhkan bermacam keahlian (skills) dari berbagai 

profesi dan organisasi. Suatu proyek merupakan upaya yang 

mengerahkan sumber daya yang tersedia, yang diorganisasikan untuk 

mencapai tujuan, sasaran dan harapan penting tertentu serta harus 

diselesaikan dalam jangka waktu terbatas sesuai dengan kesepakatan. 

(Dipohusodo, 1995). 

Proyek konstruksi yaitu suatu rangkaian kegiatan yang saling 

berkaitan untuk mencapai tujuan tertentu (bangunan/konstruksi) dalam 

batasan waktu, biaya dan mutu tertentu. Proyek konstruksi selalu 

memerlukan sumber daya (resources) yaitu manusia (man), bahan 

bangunan (material), peralatan (machine), metode pelaksanaan 

(method), uang (money), informasi (information), dan waktu (time). 

Adapun pihak-pihak yang terkait dalam pelaksanaan proyek 

konstruksi antara lain adalah pemilik (owner), perencana (konsultan), 

pelaksana (kontraktor), pengawas (konsultan), penyandang dana,  
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pemerintah (regulasi), pemakai bangunan, dan masyarakat (baik 

asosiasi maupun masyarakat umum). Sedangkan jasa konstruksi 

merupakan jasa pelayanan dalam bidang : perencanaan konstruksi, 

pelaksanaan konstruksi, pengawasan konstruksi, dan atau gabungan 

dari dua atau tiga pelayanan. 

2. Manajemen Proyek  

Manajemen proyek adalah unsur yang paling penting di dalam 

pelaksanaan proyek. Namun di dalam pelaksanaan jadwal cenderung 

tidak terpakai secara efektif di lapangan, hal ini disebabkan 

penyusunannya yang tidak didasari dengan logika-logika teknis yang 

baik dan ketidak mampuan mengendalikan jadwal yang telah 

direncanakan. Kondisi yang demikian mengakibatkan seringnya 

pelaksanaan proyek tidak sesuai dengan waktu, biaya dan mutu yang 

telah ditetapkan. (Luthan, A. L. P., & Syafriandi, 2017 : 7). 

Menurut Hendrickson (1989) Tujuan dari proses manajemen 

proyek buat konstruksi secara umum sebagai berikut: 

1) Spesifikasi tujuan proyek serta tercantum rencana penggambaran 

lapangan, anggaran, agenda, pengaturan persyaratan kinerja, serta 

pemilihan sumber energi proyek. 

2) Maksimalisasi pemanfaatan sumber daya yang efektif lewat 

pengadaan tenaga kerja, material, serta perlengkapan cocok dengan 

agenda yang sudah ditetapkan serta direncanakan. 
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3) Melaksanakan bermacam pembedahan baik lewat koordinasi serta 

pengendalian perencanaan, desain, estimasi, perjanjian serta 

pembangunan dalam seluruh proses. 

4) Pengembangan komunikasi yang efisien serta mekanisme untuk 

menuntaskan kasus diantara para pekerja. 

Dikutip dari penelitian Syahputra et al., (2017) Menurut Barrie 

(1990), berkata terdapat 6 (enam) tahapan yang membagikan 

sumbangan dalam pengembangan sesuatu proyek( siklus hidup 

proyek), mulai dari gagasan hingga selesainya proyek konstruksi 

ialah: 

1) Konsep serta Riset Kelayakan (Concept and Feasibility Studied). 

Perencanaan dalam skala luas berbentuk pemikiran konsep- 

konsep, serta riset kelayakan( ekonomi, finansial, teknis, serta 

amdal). 

2) Rekayasa serta Desain (Engineering and Design) 

Pembuatan perencanaan teknis serta desain yang ialah landasan 

operasional buat implementasi proyek dalam wujud raga. 

3) Pengadaan (Procurement). 

Membuat analisa kebutuhan bahan- bahan proyek, personil yang 

hendak digunakan dalam penerapan konstruksi, dan menolong 

pemilik dalam proses pelelangan buat penerapan konstruksi. 
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4) Konstruksi (Construction). 

Ialah proses penerapan konstruksi, dimana rencana serta 

spesifikasi dari perancangan diimplementasikan ke dalam wujud 

sarana. 

5) Pengujian serta Pelatihan dari Guna Fasilitas 

Pada tahapan ini diartikan merupakan pemeliharaan serta 

penyesuaian pemakaian sarana raga, sehabis berakhir masa 

konstruksi supaya sarana bisa berperan serta penuhi kebutuhan 

pemilik. 

6) Operasi ataupun Pemanfaatan 

Pengoperasian sarana oleh pemilik dengan tenaga terlatih serta 

manual pengoperasian cocok tujuan serta guna sarana, baik 

dicoba sendiri oleh pemilik maupun lewat jalinan kontrak (dengan 

operator ataupun manajemen proyek). 

Dikutip dari penelitian Syahputra et al., (2017) Manajemen 

konstruksi merupakan suatu ilmu yang menekuni penempatan sumber 

energi yang dicoba oleh manajer ataupun pimpinan proyek sehingga 

bisa dipergunakan sebaik- baiknya. Ada pula sumber energi yang 

diperlukan dalam dunia kontruksi meliputi tenaga kerja, perlengkapan, 

material, serta pula sumber dana. Dalam penerapannya manajemen 

konstruksi berfokus pada proses perencanaan serta kontrol dari 

sumber energi yang didasarkan pada acuan yang sudah diresmikan 

pada proyek tersebut (Halpin, 2009). 
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Tugas dari seseorang manajer konstruksi ataupun yang 

memegang peranan berarti dalam sesuatu proyek yang hendak tiba 

ataupun lagi dikerjakan merupakan buat mempraktikkan secara murah 

serta efektif sumber daya yang hendak dipergunakan buat 

merealisasikan sarana ataupun bagian yang hendak dikerjakan dengan 

mutu yang sudah penuhi ketentuan dalam jangka waktu dan bayaran 

yang di tetapkan (Halpin, 2009). 

  Dikutip dari buku manajemen proyek menurut Abrar (2011). 

Manajemen proyek memiliki 4 prinsip penting diantaranya sebagai 

berikut : 

a) Perencanaan (Planning) 

Perencanaan merupakan salah satu fungsi dalam kegiatan 

manajemen proyek. Karena itu untuk mencapai tujuan, manajemen 

harus membuat langkah-langkah proaktif dalam melakukan 

perencanaan yang komprehensif agar sasaran dan tujuan dapat di 

capai. Perencanaan dikatakan baik apa bila seluruh proses kegiatan 

yang ada didalamnya dapat di implementasikan sesuai dengan 

sasaran dan tujuan yang telah ditetapkan dengan tingkat 

penyimpanan minimal serta hasil maksimal.  

1) Tujuan Perencanaan  

 Tujuan perencanaan yaitu melakukan usaha untuk memenuhi 

persyaratan spesifikasi proyek yang ditentukan dalam batasan 

waktu, biaya dan mutu ditambah dengan terjaminnya faktor 
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keselamatan (safety). 

2) Filosofi Perencanaan. 

(a) Aman, keselamatan terjamin 

(b)  Efektif, produk perencanaan berfungsi seusai yang 

diharapkan  

(c) Efisien, produk yang dihasilkan hemat biaya 

(d) Mutu terjamin, tidak menyimpan dari spesifikasi yang di 

tentukan. (Abrar, 2011) 

b) Pengorganisasian (Organizing) 

  Kegiatan ini dilakukan indetifkasi dan pengelompokan jenis – jenis 

pekerjaan, menurutkan pedelegasikan wewenang dan tanggung 

jawab personel serta meletakan dasar bagi hubungan masing – 

masing unsur organisasi. Untuk menggerakan organisasi, pimpinan 

harus mampu mengarahkan organisasi dan menjalin komunikasi 

antara pribadi dalam organisasi. Semua itu dibangkitkan melalui 

tanggung jawab dan partisipasi semua pihak. 

 Struktur organisasi yang sesuai dengan kebutuhan proyek dan 

kerangka penjabaran tugas personal penanggung jawab yang jelas, 

serta kemampuan personel yang sesuai keahliannya diperoleh hasil 

positif bagi organisasi. (Abrar, 2011). 

c) Pelaksanaan (actuating) 

 Kegiatan ini merupakan implementasi dari perencanaan yang telah 

ditetapkan, dengan melakukan tahapan pekerjaan yang 
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sesungguhnya secara fisik atau nonfisik sehingga produk akhir 

sesuai dengan sasaran dan tujuan yang telah ditetapkan . Karena itu 

kondisi perencanaan sifatnya masih ramalan dan subyektif serta 

masih perlu penyempurnaan, dalam tahapan sering terjadi 

perubahan –perubahan dari rencana yang telah ditetapkan.Biasanya, 

tahapan pelaksanaan pihak – pihak yang terlibat lebih beragaram. 

Oleh sebab itu, diperlukan koordinasi terpadu untuk menggapai 

keserasian serta penyeimbang kerja. Tahapan ini pula telah 

ditetapkan konsep penerapan dan personel yang ikut serta pada 

organisasinya, setelah itu secara perinci  menetapkan agenda, 

alokasi biaya, program, serta alokasi sumber daya yang digunakan. 

(Abrar, 2011). 

d) Pengendalian (Controlling) 

 Menurut Abrar (2011)  Tahapan ini dimasudkan untuk memastikan 

bahwa program dan aturan kerja yang telah ditetapkan dapat dicapai 

dengan penyimpanan paling minimal dan hasil paling memuaskan. 

 Untuk itu dilakukan bentuk – bentuk kegiatan berikut: 

1) Supervisi  

 Melakukan serangkaian tindakan koordinasi pengawasan dalam 

batas wewenang dan tanggung jawab menurut prosedur 

organisasi yang telah ditetapkan, agar dalam operasional dapat 

dilakukan secara bersama – sama oleh semua personal dengan 

kendali pengawas. 
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2) Inspeksi 

 Melakukan pemeriksaan terhadap hasil pekerjaan dengan tujuan 

menjamin spesifikasi mutu dan produk sesuai dengan yang 

sudah direncanakan. 

3) Tindakan Koreksi 

 Melaksanakan pergantian serta perbaikan terhadap rencana yang 

sudah ditetapkan buat menbiasakan dengan keadaan 

pelaksanaan. 

3. Pengendalian Proyek.  

    Dikutip dari penelitian Norman, (2018) Pengendalian ialah usaha 

yang sistematis untuk menentukan standar yang sesuai dengan sasaran 

perencanaan, merancang sistem informasi, membandingkan 

pelaksanaan dengan standar, menganalisis kemungkinan adanya 

penyimpangan antara penerapan serta standar, setelah itu mengambil 

tindakan pembetulan yang dibutuhkan supaya sumber daya digunakan 

secara efisien serta efektif dalam rangka mennggapai sasaran. 

(Mockler, 1972). 

   Fungsi utama pengendalian yaitu memantau dan mengkaji agar 

langkah-langkah kegiatan terbimbing ke arah tujuan yang telah 

ditetapkan. Pengendalian dicoba dengan memantau hasil aktivitas yang 

sudah dilaksanakan sesuai dengan patokan yang sudah digariskan serta 

membenarkan penggunaan sumber daya yang efisien dan efektif. 
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   Dikutip dari penelitian Norman, (2018) Pengendalian juga merupakan 

suatu usaha untuk menghindari persoalan yang umumnya sering 

dijumpai dalam suatu pelaksaan proyek, perlu adanya suatu laporan 

harian sebagai alat bantu untuk mempermudah mengontrol suatu 

proyek agar tetap berjalan sesuai dengan yang direncanakan.  

 Kriteria-kriteria yang digunakan untuk mengukur kemajuan proyek 

sebagai berikut: 

1) Waktu, mengetahui sejak awal setiap gejala yang menyimpang 

dari rencana sehingga dapat segera diambil tindakan untuk 

menyelesaikan masalah tersebut. 

2) Biaya, mengendalikan dan memonitor penggunaan anggaran 

proyek yang biasanya juga dinyatakan dengan rencana presentasi 

pengeluaran per satuan waktu. 

3) Mutu, mengukur keberhasilan suatu proyek yang dilakukan pada 

akhir proyek dengan berbagai cara pengujian dalam penilaian 

mutu suatu proyek. 

 

        Biaya 

 

 

     

      Waktu     Mutu   

      Gambar 2.1 Hubungan Biaya , Waktu, dan Mutu  
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4. Penjadwalan Proyek (Time Schedule). 

    Dikutip dari jurnal Syahputra et al., (2017) Jadwal yaitu 

Perencanaan proyek menjadi urutan langkah- langkah pelaksanaan 

pekerjaan untuk mencapai sasaran. Pada jadwal telah dimasukan faktor 

waktu. Metode menyusun jadwal yang terkenal merupakan analisis 

jaringan (network), yang menggambarkan dalam suatu grafik 

hubungan urutan pekerjaan proyek. Pekerjaan yang wajib mendahului 

ataupun didahului oleh pekerjaan lain diidentifikasi dalam kaitanya 

dengan waktu. Jaringan kerja ini sangat berguna untuk perencanaan 

serta pengendalian proyek (Soeharto, 1997). 

   Penjadwalan dalam proyek merupakan perangkat untuk menentukan 

aktivitas yang diperlukan untuk menyelesaikan suatu proyek dalam 

urutan serta kerangka waktu tertentu, dalam mana setiap aktivitas 

harus dilaksanakan agar proyek selesai tepat waktu dengan biaya yang 

optimal (Callahan, 1992). 

a) Manfaat yang dapat diperoleh dari penjadwalan antara lain : 

1) Bagi Pemilik 

(a) Mengetahui waktu mulai dan selesainya proyek. 

(b) Merencanakan alirankas atau biaya. 

(c) Mengevaluasi efek perbahan terhadap waktu penyelesaian 

dan biaya proyek. 
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2) Bagi Kontraktor 

(a) Memprediksi durasi suatu kegiatan yang spesifik dimulai 

dan diakhiri. 

(b) Merencanakan kebutuhan material, peralatan, dan tenaga 

kerja. 

(c) Mengatur waktu keterlibatansub-kontraktor. 

(d) Menghindari konflik antara sub-kontraktor dan pekerja. 

(e) Merencanakan alirankas dan biaya. 

(f) Mengevaluasi efek perubahan terhadap waktu penyelesaian 

dan biaya proyek. 

Menurut Heizer & Render (2009) bahwa penjadwalan proyek 

memiliki beberapa tujuan sebagai berikut: 

a) Untuk menunjukkan hubungan masing-masing pekerjaan 

dengan pekerjaan lain dan keseluruhanproyek. 

b) Untuk mengidentifikasi tingkat hubungan antara pekerjaan 

c) Untuk mendorong pengaturan terhadap realistis waktu dan 

perkiraan biaya untuk setiap pekerjaan. 

d) Untuk membantu menjadi lebih baik menggunakan pekerja, 

biaya, dan material dengan mengidentifikasi lintasan kritis 

dalam proyek. 

5. Critical Path  Method (CPM) 

   Dikutip pada penelitian Syahputra et al., 2017 menurut Newbold 

(Stelth dan Roy, 2009) Critical Path  Method (CPM) merupakan 
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proses menganalisis proyek dengan menentukan urutan pekerjaan 

terpanjang dengan melalui jaringan proyek. Dengan 

mengonsentrsikan pada pekerjaan yang paling penting dapat 

dipastikan bahwa proyek tersebut tepat waktu dengan kecepatan 

dengan pengaturan penjadwalan. Dalam  metode CPM (Critical Path  

Method) di sebut juga jalur kritis ialah jalur yang mempunyai 

rangkaian atau komponen kegiatan dengan jumlah waktu lama. Jalur 

kritis terdapat rangkaian kegiatan kritis, diawali dari kegiatan pertama 

sampai pada kegiatan akhir oada proyek (Soeharto, 1999). 

 Menurut waktu penyelesaian pada metode CPM (Ervianto, 2004): 

a) Earliest Activity Start Time ( ES) 

  ES adalah waktu yang tercepat suatu kegiatan aktivitas dapat 

dimulai atau waktu mulai paling awal suatu kegiatan dengan 

memperhatikan waktu kegiatan. 

b) Latest Activity Start Time (LS) 

  LS adalah waktu paling lambat untuk memulai kegiatan  

c) Earliest Activity Finish Time (EF) 

  EF adalah waktu tercepat kegiatan dapat di selesaikan. EF = suatu 

kegiatan terdahulu = ES kegiatan berikutnya  

d) Latest Finish Time (LF) 

  LF adalah waktu paling lambat dalam menyelesaikan suatu 

kegiatan  
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6. Kurva S (Hanumm Curve)  

   Dikutip dari penelitian Norman, (2018) Kurva S merupakan 

penggambaran kemajuan kerja (bobot) kumulatif pada sumbu 

horizontal. Kemajuan aktivitas umumnya diukur terhadap jumlah biaya 

yang sudah dikeluarkan oleh proyek. Perbandingan kurva S rencana 

dengan kurva penerapan membolehkan bisa diketahuinya kemajuan 

penerapan proyek apakah cocok, lambat, maupun lebih dari yang 

direncanakan. 

   Buat memastikan bobot pekerjaan, pendekatan dicoba bisa 

berbentuk perhitungan presentase bersumber pada biaya per item 

pekerjaan/kegiatan dipecah nilai anggaran, sebab  itu satuan biaya 

dapat dijadikan wujud presentase sehingga lebih mudah untuk 

menghitungnya.  

 

Gambar 2.2 Kurva S 
(Sumber: www.johnmil.wordpress.com) 

http://www.johnmil.wordpress.com/
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7. Metode Time Cost Trade Off  (TCTO) 

   Dikutip dari penelitian Hendriyani et al., (2020) Time Cost Trade 

Off ialah kompresi jadwal untuk mendapatkan proyek yang lebih 

menguntungkan dari segi waktu, biaya serta  pendapatan. Tujuannya 

ialah untuk memanfaatkan proyek dengan durasi yang dapat diterima 

dan menimaliskan biaya total proyek. Pengurangan durasi proyek 

dilakukan dengan memilih aktivitas tertentu dengan jalur kritis. 

   Dalam analisa metode Time Cost Trade Off ini dengan 

berubahnya waktu penyelesaian proyek hingga berganti pula biaya 

yang hendak dikeluarkan. Apabila waktu penerapan dipercepat 

hingga biaya langsung proyek akan meningkat serta biaya tidak 

langsung proyek akan menurun. 

   Metode yang bisa digunakan untuk melakukan percepatan 

penyeleseian waktu proyek tersebut antara lain: 

a) Penambahan  jumlah jam kerja (kerja lembur). 

b) Penambahan tenaga kerja. 

c) Pergantian ataupun penambahan alat. 

d) Pemilihan sumber daya manusia yang bermutu, 

e) Pemakaian tata cara konstruksi yang efisien. 

   Cara- cara tersebut bisa dilaksanakan secara terpisah ataupun 

campuran, selaku contoh: campuran penambahan jam kerja (lembur) 

sekalian penambahan jumlah tenaga kerja, biasa disebut giliran ( 

shift), dengan unit pekerja buat pagi hingga sore berbeda dengan 
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dengan unit pekerja buat sore hingga malam. 

8. Produktivitas Tenaga Kerja 

  Produktivitas yaitu selaku rasio antara output serta input, ataupun 

bisa dikatakan sebagai rasio antara hasil produksi dengan total 

sumber daya yang digunakan. Pada proyek konstruksi, rasio 

produktivitas merupakan nilai yang diukur sepanjang proses 

konstruksi, bisa dijabarkan menjadi biaya tenaga kerja, material, 

uang, metode serta perlengkapan. 

   Faktor- Faktor yang Pengaruhi Produktivitas Tenaga Kerja, 

Variabel- variabel yang pengaruhi produktivtas tenaga kerja lapangan 

bisa di kelompokkan jadi: 

a)  Keadaan Fisik Lapangan 

  Keadaan fisik geografis posisi proyek mempengaruhi terhadap 

produktivitas tenaga kerja. Keadaan fisik ini berbentuk: 

1)  Iklim Musim ataupun Kondisi Cuaca. 

 Semacam terdapatnya temperatur udara panas, dingin, hujan 

serta salju. Didaerah tropis dengan kelembaban udara yang 

besar bisa mempercepat rasa letih pada tenaga kerja. 

Kebalikannya didaerah dingin apabila masa salju datang 

produktivitas tenaga dilapangan akan menyusut. 

2) Kondisi Fisik Lapangan. 

 Keadaan fisik lapangan kerja semacam rawa- rawa, padang 

pasir, ataupun tanah berbatu keras mempengaruhi besar 
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terhadap produktivitas tenaga kerja. 

3) Fasilitas Bantu. 

 Minimnya kelengkapan fasilitas bantu semacam perlengkapan 

konstruksi (construction equipment & tools) hendak 

menaikkan jam- orang buat menuntaskan pekerjaan selaku 

contoh dump truck, grader, tower crane, serta lain- lain. 

b) Supervisor, Perencanaan, serta Koordinasi 

  Supervisor merupakan seluruh suatu yang berhubungan langsung 

dengan tugas pengelolaan para tenaga kerja, mengetuai para 

pekerja dalam pelaksaanan tugas tercantum menjabarkan 

perencanaan serta pengendalian jadi langkah- langkah penerapan 

jangka pendek dan mengkoordinasikan dengan rekan ataupun 

supervisor yang lain. 

c)    Komposisi Kelompok Kerja 

  Komposisi kelompok kerja mempengaruhi terhadap produktivitas 

tenaga kerja secara totalitas. Yang diartikan dengan komposisi 

kelompok kerja merupakan. 

1) Perbandingan jam atau orang penyelia serta pekerja yang 

dipimpinnya. 

2) Perbandingan jam atau orang buat disiplin- disiplin kerja 

dalam kelompok kerja. 

d)  Kerja Lembur 

   Kerja lembur ataupun kerja yang panjang lebih dari 40 jam per 
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minggu tidak bisa dihindari, misalnya untuk mengejar target 

agenda, walaupun itu merendahkan efisiensi kerja. 

Memperkirakan waktu penyelesaian proyek dengan memikirkan 

kerja lembur butuh dicermati peningkatan total jam dan orang.  

9. Penambahan Jam Kerja ( Lembur ) 

   Dikutip dari penelitian Syahputra et al., (2017) Strategi untuk 

mempercepat waktu penyelesaian proyek merupakan dengan 

menaikkan jam kerja( lembur) perlengkapan. Penambahan dari jam 

kerja (lembur) ini sangat kerap dicoba disebabkan bisa 

memberdayakan sumber daya yang telah terdapat dilapangan serta 

cukup dengan mengefisienkan tambahan biaya yang hendak 

dikeluarkan oleh kontraktor. Umumnya waktu kerja wajar pekerja 

merupakan 7 jam ( diawali jam 08.00 serta berakhir jam 16.00 

dengan satu jam istirahat ), setelah itu jam lembur dilakukan sehabis 

jam kerja normal berakhir. 

  Berdasarkan Keputusan Menteri Tenaga Kerja dan Transmigrasi 

Republik Indonesia Nomor KEP. 102/MEN/VI/2004 pasal 3, waktu 

kerja lembur hanya dapat dilakukan paling banyak 3 (tiga) jam dalam 

1 (satu) hari dan 14 (empat belas) jam dalam 1 (satu) minggu. 

  Penambahan jam kerja (lembur) dapat dicoba dengan 

melaksanakan Penambahan 1 jam, 2 jam, serta 3 jam cocok dengan 

waktu penambahan yang di inginkan. Semakin besar Penambahan 

jam lembur bisa memunculkan penyusutan produktivitas, gejala dari 
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penyusutan produktivitas operator serta pembantu operator terhadap 

penambahan jam kerja ( lembur) bisa dilihat pada Gambar 2.8. Nilai 

koefisien penurunan produktivitas tersebut bisa dilihat pada Tabel 

2.1. 

 
Gambar 2.3  Grafik Indeks Penurunan Produktivitas Jam Lembur 

(sumber : Soeharto, 1997) 

 

Jam Lembur 
Penurunan Indeks 

Produktivitas 
Prestasi Kerja 

1 Jam 0,1 90 

2 Jam 0,2 80 

3 Jam 0,3 70 

Tabel 2.1 Nilai Koefisien Penurunan Produktivitas Crash 

Duration 

 

   Grafik di atas dapat diuraikan sebagai berikut : 

  

  Volume  

a) Produktivitas Harian =    

   Durasi Normal  

Produktivitas Harian 

b) Produktivitas Tiap Jam = 

      Jam Kerja Perhari  
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c) Produktivitas Harian Akibat Kerja Lembur =  

(a x b x produktivitas tiap jam) 

Dengan : 

a = jumlah penambahan jam kerja ( lembur ) 

b = Koefisien Penurunan Produktivitas akibat Penambahan 

Jam Kerja ( lembur ) 

d) Crash Duration  =     Volume  

    Produktivitas Harian Sesudah Crashing 

 

10. Biaya Penambahan Kerja (Crash Cost) 

Dikutip dari jurnal Mandiyo et al., (2017) Penambahan waktu 

kerja akan menambah besar biaya untuk tenaga kerja dari biaya 

normal tenaga kerja. Berdasarkan Keputusan Menteri Tenaga Kerja 

dan Transmigrasi Republik Indonesia Nomor KEP. 

102/MEN/VI/2004 bahwa upah penambahan kerja bervariasi. Pada 

penambahan waktu kerja satu jam pertama, pekerja mendapatkan 

tambahan upah 1,5 kali upah perjam waktu normal dan pada 

penambahan jam kerja berikutnya maka pekerja akan mendapatkan 2 

kali upah perjam waktu normal. 

Perhitungan untuk biaya tambahan pekerja dapat dirumuskan 

sebagai berikut ini: 

a) Normal upah pekerja perhari  

= Produktivitas harian x Harga satuan upah pekerja 
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b) Normal upah pekerja perjam  

= Produktivitas perjam x Harga satuan upah pekerja 

c) Biaya lembur pekerja  

= 1,5 x upah sejam normal untuk penambahan jam kerja (lembur) 

pertama + 2 x n x upah satu jam normal untuk penambahan jam 

kerja (lembur) berikutnya 

dengan: 

n = jumlah penambahan jam kerja (lembur) 

d) Crash cost pekerja perhari  

= (Jam kerja perhari x Normal cost pekerja) + (n x Biaya lembur 

perjam) 

e) Cost slope 

= Crash cost – Normal cost  

Durasi normal – durasi crash  

11. Biaya Proyek  

Penggerak untuk berjalannya proyek yaitu pembiayaan. Biaya 

yang dimaksudkan merupakan seluruh biaya yang berhubungan, baik 

langsung  atau tidak langsung dengan proyek tersebut, termasuk biaya 

yang dikelurkan untuk pengadaan sumber daya dan seluruh biaya 

yang digolongkan dalam biaya overhead  maupun biaya tetap lainnya. 

(Luthan, A. L. P., & Syafriandi, 2017 : 123). 

a) Biaya Langsung ( Direct cost ) 
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Menurut Luthan, A. L. P., & Syafriandi (2017 : 124) Biaya 

langsung yaitu biaya yang langsung berpengaruh terhadap 

pelaksanaan fisik proyek, bisa juga disebut biaya tenaga kerja. 

Termasuk biaya langsung adalah : 

1) Biaya bahan, dengan memperhatikan spesifikasi, kualitas 

dan kuantitas bahan yang dibutuhkan dapat dilakukan 

perhitungan biaya untuk bahan.  

2) Biaya tenaga kerja, biaya ini diperhitungkan dengan 

memperkirakan keahlian dan jumlah yang dipakai untuk 

melaksanakan setiap kegiatan proyek.  

3) Biaya sub-kontraktor ialah biaya yang dikeluarkan untuk 

kegiatan – kegiatan tertentu yang dilaksanakan oleh pihak 

lain.  

4) Biaya peralatan, pada proyek umumnya biaya peralatan ini 

digolongkan sebagai jenis biaya tersendiri, biaya ini dapat 

merupakan sewa atau biaya penyusutan peralatan. 

b) Biaya Tidak Langsung ( Indirect cost ) 

Menurut Luthan, A. L. P., & Syafriandi (2017 : 125) Biaya 

tidak langsung merupakan pengeluaran untuk manajemen, 

dimana biaya ini dikeluarkan untuk dapat melancarkan 

pelaksanaan proyek, biaya – biaya tersebut : 

1) Biaya umum proyek , yang termasuk biaya ini misalnya 
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biaya pembangunan fasilitas sementara, gaji karyawan, 

penyediaan transportasi, listrik, air dan lainnya . 

2) Keuntungan , biaya ini biasanya diperhitungkan untuk 

melengkapi penawaran proyek.  

12. Hubungan antara Biaya dan Waktu 

Dikutip dari penelitian Syahputra et al.,  (2017) Biaya total 

proyek merupakan penjumlahan dari biaya langsung dan biaya tak 

langsung. Besarnya bayaran ini sangat bergantung oleh lamanya 

waktu (durasi) penyelesaian proyek. Keduanya berubah sesuai 

dengan waktu dan kemajuan proyek. Walaupun tidak dapat dihitung 

dengan rumus tertentu, akan tetapi umumnya makin lama proyek 

berjalan makin tinggi kumulatif biaya tak langsung yang 

dipergunakan (Soeharto, 1997). 

Biaya total proyek sama dengan penjumlahan dari biaya langsung 

serta biaya tidak langsung. Biaya total proyek sangat bergantung dari 

waktu penyelesaian proyek. Hubungan antara biaya dengan waktu 

dapat dilihat pada Gambar 2.10. Titik A pada gambar menampilkan 

keadaan normal, sebaliknya Titik B menampilkan keadaan 

dipercepat. Garis yang menghubungkan antar titik tersebut disebut 

dengan kurva waktu biaya.  

Gambar 2.10 memperlihatkan bahwa semakin besar penambahan 

jumlah jam kerja (lembur) hingga akan semakin cepat waktu 

penyelesain proyek, akan tetapi sebagai konsekuesinya maka terjadi 
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biaya tambahan yang harus dikeluarkan akan semakin besar. 

 

Gambar 2.4 Hubungan waktu-biaya normal dan dipercepat 

untuk suatu kegiatan (Soeharto,1997). 

 

 

 

 

 

 

 

Gambar 2.5 Hubungan biaya langsung, biaya tak langsung dan 

biaya total proyek (Soeharto, 1997). 

Dikutip dari penelitian Syahputra et al., (2017) Menurut Yana 

(2009) hubungan semacam ini disebabkan karena setiap percepatan 

durasi proyek membutuhkan tambahan biaya langsung yang 

digunakan untuk menambah tingkat produktivitas kerja, menambah 
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peralatan, mengganti metode kerja, dan lain-lain. Antara waktu 

penyelesaian proyek normal serta dipercepat menimbulkan 

perubahan terhadap biaya total proyek.  

Untuk menganalisis lebih lanjut hubungan antara biaya dan 

waktu suatu kegiatan, digunakan definisi sebagai berikut : 

a) Kurun waktu normal, yaitu jangka waktu yang diperlukan untuk 

melakukan kegiatan sampai selesai dengan tingkat produktivitas 

kerja yang normal. 

b) Kurun waktu dipersingkat, yaitu waktu tersingkat untuk 

menyelesaikan suatu kegiatan yang secara teknis masih 

mungkin. 

c) Biaya normal, yaitu biaya langsung yang diperlukan untuk 

menyelesaikan kegiatan dengan kurun waktu normal. 

d) Biaya untuk waktu dipersingkat, yaitu jumlah biaya langsung 

untuk menyelesaikan pekerjaan dengan kurun waktu tersingkat. 

13. Microsoft Project 2013. 

  Microsoft Project 2013 merupakan sistem proyek perangkat lunak 

manajemen yang dikembangkan dan dijual oleh Microsoft, yang 

dirancang untuk membantu manajer proyek dalam mengembangkan 

rencana, menetapkan sumber daya untuk tugas-tugas, pelacakan 

kemajuan, mengelola anggaran, dan menganalisis beban kerja.   

Jadwal dapat menjadi sumber daya diratakan, dan jaringan  tugas 

yang divisualisasikan dalam grafik Gantt.  
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 Manfaat dari Microsoft Project adalah : 

a) Menyimpan detail mengenai proyek di dalam database-nya yang 

meliputi detail tugas-tugas beserta hubungannya satu dengan yang 

lain, sumber daya yang dipakai, biaya, jalur kritis, danlain-lain. 

b) Menggunakan informasi tersebut untuk menghitung dan 

memelihara jadwal, biaya dan elemen-elemen lain termasuk juga 

menciptakan suatu rencana proyek. 

c) Melakukan pelacakan selama proyek berjalan untuk menentukan 

apakah proyek akan dapat diselesaikan tepat waktu dan sesuai 

anggaran yang direncanakan atau tidak. 

  Istilah- istilah yang digunakan pada Microsoft Project ialah: 

a) Task 

 Task ialah salah satu wujud lembar kerja dari Microsoft 

Project yang berisi rincian pekerjaan suatu proyek 

b) Duration  

 Duration ialah jangka waktu yang dibutuhkan buat 

menuntaskan suatu pekerjaan 

c) Start 

 Start ialah nilai bertepatan pada dimulainya sesuatu pekerjaan 

d) Finish 

 Waktu selesainya pekerjaan yang akan berisi secara otomatis 

dari perhitungan tangal mulai start ditambah lama pekerjaan 

duration  
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B 

B 

e) Predecessor  

 Predecessor ialah ikatan keterkaitan antara suatu pekerjaan 

dengan pekerjaan lain. Ada 4 hubungan di Microsoft Project, 

ialah : 

1) FS (Finish to Start) 

Sesuatu pekerjaan baru boleh diawali bila pekerjaan 

yang lain berakhir, dilihat gambar 2. 

 

 

Gambar 2.6 FS (Finish to Start) 

2) FF (Finish to Finish) 

Sesuatu pekerjaan wajib berakhir bertepatan dengan 

selesainya pekerjaan lain, dilihat gambar 2. 

 

 

Gambar 2.7 FF (Finish to Finish) 

3) SS (Start to Start) 

 Sesuatu pekerjaan wajib diawali bertepatan dengan 

pekerjaan lain,  

 

 

Gambar 2.8 SS (Start to Start) 

 

B 
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4) SF (Start to Finish) 

Sesuatu pekerjaan baru boleh diakhiri bila pekerjaan 

lain diawali,  

 

 

Gambar 2.9 SF (Start to Finish) 

f) Resources 

 Sumber energi, baik sumber energi manusia ataupun material 

dalam Microsoft Project diucap dengan resources. 

g) Baseline 

 Baseline merupakan sesuatu rencana baik agenda ataupun 

bayaran yang sudah disetujui serta diresmikan. 

a) Tujuan penjadwalan dalam Microsoft Project adalah : 

1) Mengetahui durasi kerja proyek. 

2) Membuat durasi optimum. 

3) Mengendalikan jadwal yang dibuat. 

4) Mengalokasikan sumber daya (Resources) yang digunakan.  

b) Komponen yang di butuhkan pada jadwal adalah: 

1) Kegiatan (rincian tugas, tugas utama). 

2) Durasi kerja untuk tiap kegiatan. 

3) Hubungan kerja tiap kegiatan. 

4) Resources (tenaga kerja dan bahan). 

 

B 
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B. Tinjauan Pustaka 

1. Isradias Mirajhusnitaa, Saufik Luthfianto, (2020) Penelitian ini 

berjudul “Optimalisasi Waktu Dan Biaya Proyek Dengan Metode 

Crash Program” (Studi Kasus: Proyek Pembangunan Gedung “K” 

UMP).Tujuan penelitian ini yang pertama untuk mengetahui 

pekerjaan apa saja yang termasuk dalam cross critical dan bentuk 

perencanaan jaringan dengan menggunakan aplikasi QSB windows 

yang kedua untuk mengetahui waktu dan biaya yang optimal dalam 

mempercepat waktu pembangunan K gedung. Penelitian ini 

menggunakan metode crash program yaitu ntuk menghemat waktu, 

percepatan dilakukan dengan menambahkan jam lembur selama 4 

jam . Setelah dilakukan akselerasi, setelah terjadi crash pada 

pekerjaan kritis yang dihasilkan adalah 175 hari kerja dengan selisih 

58 hari dari durasi normal 247 hari. Dampak yang ditimbulkan oleh 

perubahan waktu pada biaya tersebut adalah peningkatan biaya 

langsung menjadi Rp. 8.624.930.090,12. Sedangkan setelah crash 

durasi proyek menjadi lebih pendek menyebabkan penurunan biaya 

tidak langsung menjadi Rp. 1.058.595.050,81. 

2. Irna Hendriyani, Reno Nour Qadri, (2020) Penelitian ini berjudul 

“Optimasi Waktu Dan Biaya Pada Pelaksanaan Proyek Peningkatan 

Jalan Bina Bakti Kelurahan Gunung Seteleng Kabupaten Penajam 

Paser Utara Dengan Metode Time Cost Trade Off (TCTO)”. Proyek 

Peningkatan Jalan Bina BaktiKelurahan Gunung Seteleng Kabupaten 
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Penajam Paser Utara  dipilih sebagai objek penelitian dengan panjang  

jalan  569  Meter  dan  anggaran  proyek  senilai  Rp.1.222.038.477,10  

karena  proyek  ini mengalami keterlambatan. Metode ini 

menggunakan penambahan jam kerja lembur  dan  penambahan  

tenaga  kerja.  Waktu  pelaksanaan  proyek  Peningkatan  Jalan  Bina  

Bakti selama  54  hari  kalender. Hasil  penelitian  waktu  dan  biaya  

paling  optimum  setelah  penambahan  jam  kerja  lembur  didapatkan  

total  biaya  optimum  Rp.1.220.695.370,54  dan  durasi crashing  42,4 

hari dengan efisiensi biaya 0,11% dan efisiensi waktu 13,47%.  Untuk 

penambahan tenaga kerja didapatkan waktu dan  total biaya optimum 

Rp.1.215.485.807,44 dan durasi  crashing 37,8  hari  dengan  efisiensi  

biaya  0,54%  dan  efisiensi  waktu  22,86%.  

3. Rizky Widyo Kisworo, Fajar Sri Handayani, Sunarmasto, (2017) 

Penelitian ini berjudul “Analisis Percepatan Proyek Menggunakan 

Metode Time Cost Trade Off  Dengan Penambahan Jam Kerja Lembur 

Dan Jumlah Alat”. Proyek pembangunan Jalan Tol Semarang -Solo 

Ruas Bawen-Solo Seksi II dengan panjang 1,3 km, yang berlokasi di 

Desa Ngargosari, Kecamatan Ampel, Kabupaten Boyolali. Metode 

yang dapat digunakan adalah metode  time cost trade off. Alternatif 

yang digunakan adalah  dengan  penambahan  jam  kerja  lembur  dan  

kapasitas  alat  optimum.  Tujuan  penelitian untuk  mempercepat 

waktu pelaksanaan proyek dengan penambahan biaya minimum, 

menganalisis sejauh mana waktu dapat dipersingkat. Hasil dari 
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Penelitian  ini  menunjukkan pada  proses  crashing  tahap  ke -28  

dengan  penambahan  jam  kerja lembur  mempunyai  biaya  optimal  

proyek  sebesar  Rp  39.236.409.113,12  efisiensi  biaya  sebesar  

0,29%   dengan  waktu penyelesaian  proyek  191  hari  dan  efisiensi  

waktu  sebesar  22,0408%.  Alternatif  penambahan  kapasitas  alat  

menghasilkan waktu  optimal 212  hari  dengan  efisiensi  waktu  

sebesar  0,015%  dan  biaya  optimal  Rp  39.342.963.710,11  dengan  

efisiensi biaya sebesar 13,4694% pada proses crashing tahap ke-7. 

4. Fajar Sri Handayani, R.A Imareta Sulistiofanny, Sugiyanto, (2017). 

Penelitian ini berjudul “ Penerapan Time Cost Trade Off Dalam 

Optimalisasi Biaya Dan Waktu Dengan Penambahan Jam Kerja Dan 

Kapasitas Alat (Studi Kasus Proyek Pembangunan Jalan Tol Solo-

Semarang, Ruas Bawen-Solo Seksi II)“.tujuan dari penelitian untuk 

mempercepat waktu penerapan proyek dan menganalisis sepanjang 

mana waktu dapat dipersingkat dengan penambahan biaya minimum 

terhadap aktivitas yang bisa dipercepat kurun waktu penerapanya. 

metode time  cost  trade off  dengan  proses  crashing  menggunakan  

alternatif  penambahan  shift  kerja dan kapasitas  alat. Penelitian ini 

bahwa pada proses  crashing  tahap ke-29 dengan penambahan shift 

kerja mempunyai biaya optimal proyek sebesar Rp 39.004.862.707,70 

efisiensi biaya 0,875% dengan waktu penyelesaian proyek 119 hari 

efisiensi waktu  50%. Sedangkan alternatif shift  kerja menghasilkan 

waktu optimal 189 hari efisiensi  waktu 20,588% dan biaya optimal Rp 
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39.205.747.076,44 efisiensi biaya  0,364%  pada proses crashing tahap 

ke -6. 

5. Mandiyo Priyo, Sarwidi Surido, (2017) Penelitian ini berjudul “ Studi 

Optimasi Waktu Dan Biaya Dengan Metode Time Cost Trade Off 

Pada Proyek Kontruksi : Studi Kasus Proyek Jalan Bigel-Galur-

Poncosari Cs. Tahap I, Provinsi D.I Yogyakarta”.Penelitian ini 

menggunakan Microsoft Project 2010 dan metode yang digunakan 

pertukaran biaya waktu..Hasil dari penelitian adalah tambahan 1 jam 

kerja didapat durasi 110,03 hari. Penambahan 2  jam kerja yang 

didapat dari durasi 62,1 hari. Penambahan peralatan durasi 1 jam 

tambahan jam kerja dengan durasi crashing 110,03 hari. Penambahan 

peralatan dan pemberi kerja dengan durasi 2 jam kerja tambahan 

dengan durasi menerjang 62.1 hari.  

6. Aulia Putri Andita, (2017) penelitian ini berjudul “Analisis 

Pemampatan Waktu Terhadap Biaya Pada Pembangunan My Tower 

Hotel & Apartment Project Dengan Menggunakan Metode Time Cost 

Trade Off (TCTO)”  tujuan dari penelitian adalah menentukan biaya 

dan durasi optimum proyek dari hasil percepatan alternatif yaitu 

dengan penambahan jam kerja. Hasil dari percepatan menggunakan 

metode time cost trade off adalah 272 hari dengan biaya optimum Rp 

40.555.095.100,00. 

7. Dita Nafa Anggraeni, Meriana Wahyu Nugroho, Sumarsono (2019) 

Penelitian ini berjudul “Optimasi Waktu Dan Biaya Crashing Dengan 
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Menggunakan Metode Time Cost Trade Off” tujuan dari penelitian ini 

adalah untuk mengoptimalkan waktu dan biaya minimal, metode yang 

digunakan CPM dengan mencari lintas krisis. Hasil dari penelitian ini 

dengan menggunakan alternatif 4 jam kerja lembur dengan durasi 597 

hari dengan 31.893.210.841. sehingga alternatif ini lebih optimal 

dibandingkan 2 jam kerja lembur.  

8. Achmad Darmadi, (2019). Penelitian ini berjudul “Analisa Percepatan 

Durasi Dengan Metode Time Cost Trade Off” (Studi Kasus: Pada 

Proyek Peningkatan Jalan Bukit Seribu (Lapen-Rigid) Kota 

Samarinda. Tujuan dari penelitian ini menentukan durasi optimum 

yang didapat dengan penambahan jam kerja. Hasil penelitian 

penambahan jam kerja lembur 125 hari dengan efisiensi waktu 

optimum 89,29% dengan biaya meningkat Rp. 8.958.810.455,30. 

Sedangkan penambahan jumlah tenaga kerja 133 hari dengan efisiensi 

waktu 95% dengan biaya meningkat Rp. 8.923.259.889,77. 

9. Imay Zulkasa, Budiono, Budi Arief, (2018). Penelitian ini berjudul 

“Percepatan Pelaksanaan Pekerjaan Proyek Jalan Serua Raya Depok 

Dengan Metode Time Cost Trade Off”. Tujuan dari penelitian adalah 

untuk menganalisis percepatan dengan waktu maksimal dengan biaya 

percepatan minimal. Alternatif ini dengan menggunakan metode time 

cost trade off dengan penambahan tenaga kerja. Hasil penelitian ini 

menyebabkan pengurangan hari dengan biaya Rp. 104,652,128 dengan 

total biaya yang dikelurkan Rp. 1.215.117.000. 
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10. Septian Pratama, Muhammad Fauzi, Samsul Bahri, (2019). Penelitian 

ini berjudul “ Optimasi Biaya Dan Waktu Proyek Dengan Penambahan 

Jam Kerja(Lembur) Dibandingkan Dengan Penambahan Tenaga Kerja 

Menggunakan Metode Time Cost Trade Off”. Penelitian ini 

menggunakan program Microsoft Project dengan mencari lintas kritis 

dilakukan metode time cost trade off melakukan penambahan jam 

kerja dan tenaga kerja. Hasil penelitian dengan penambahan jam kerja 

menghasilkan waktu 12,03% dengan efisiensi biaya 0,674% dan 

penambahan tenaga kerja 28 orang  menghasilkan waktu 11,28% 

dengan efisiensi biaya 0,438%.  
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BAB III 

METODOLOGI PENELITIAN 

A. Metode Penelitian  

Metode Penelitian adalah tata cara ataupun langkah yang dimiliki 

serta dilakukan oleh peneliti dalam rangka untuk mengumpulkan 

informasi atau data serta melakukan penelitian pada data yang telah 

didapatkan. Metode penelitian memberikan gambaran rancangan 

penelitian yang meliputi prosedur dan langkah-langkah yang harus 

ditempuh, waktu penelitian, sumber data, dan dengan langkah apa 

data-data tersebut diperoleh dan selanjutnya dianalisa. 

Metode yang digunakan dalam penelitian ini adalah deskriptif 

kualitatif, ialah metode penelitian yang dimaksudkan untuk  

mengumpulkan informasi  mengenai gejala atau peristiwa yang ada. 

penelitian ini bertujuan untuk menggambarkan atau mendeskripsikan 

masalah pada studi kasus. Data yang telah diperoleh pada saat 

penelitian ini tidak hanya disusun dan dikumpulkan tetapi juga 

meliputi analisis data tersebut sehingga menghasilkan hasil akhir yang 

dapat ditarik kesimpulkan.    

Metode Time Cost Trade Off untuk mengetahui waktu yang dapat 

dipercepat dan biaya yang dihasilkan pada proyek setelah dilakukan 

percepatan dengan cara penambahan jam kerja pada durasi waktu 

normal lalu percepatan dengan penambahan jam kerja (lembur) akan di
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bandingkan dan biayanya dengan pekerjaan normal yang tidak 

dilakukan percepatan sehingga akan mengetahui mana yang lebih 

menguntungkan.  

B. Waktu dan Tempat Penelitian 

Objek penelitian ini mengambil pada proyek Peningkatan Jalan 

Kaligangsa Wetan – Randusanga Wetan , Terletak di Jl. Parintis 

Kemerdekaan Desa Kaligangsa Wetan, Kabupaten Brebes, Jawa 

Tengah 52212, Oleh CV. Mulya Jaya sebagai Kontraktor dan CV. 

Papan Desain sebagai Konsultan Pengawas. Proyek ini bernilai Rp. 

1.482.125.000,00. Waktu yang dijadwalkan untuk menyelesaikan 

poyek ini adalah selama 45 (empat puluh lima) Hari kalender sejak 

tanggal : 10 November 2020 – 24 Desember 2020.  

 

 

 

 

 

 

 

 

 

Gambar 3.1 Lokasi Proyek Jalan 

(Sumber : Google Maps) 
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C. Metode Penentuan Sampel 

1. Populasi  

Populasi merupakan sumber data penelitian yang cukup untuk 

digunakan dalam proses penelitian. Populasi dalam penelitian ini 

yaitu Proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga 

Wetan Kabupaten Brebes.  

2. Sampel  

Sampel bisa diartikan sebagai bagian dari populasi yang 

menjadikan sumber data sebenarnya dalam suatu penelitian atau 

juga sebagaian data populasi yang bisa terwakilkan dari objek 

suatu penelitian. Dalam penelitian ini yang dijadikan sebagai 

sampel adalah waktu, biaya, jam kerja lembur dan tenaga kerja.   

3. Teknik Pengambilan Sampel  

Teknik pengambilan sampel hal yang penting dalam penelitian 

tersebut. Teknik Pengambilan sampel ini dilakukan dengan cara 

Purposive Sampling. Purposive Sampling yaitu dengan teknik 

pengambilan sampel berdasarkan kriteria tertentu. Dalam 

penelitian ini kriteria dibatasi yaitu : 

a) Proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga 

Wetan.  

b) Waktu dan Biaya Normal  

c) Metode Time Cost Trade Off dengan waktu 1 jam lembur, 2 

jam lembur, dan 3 jam lembur. 
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d) Menggunkan Program Microsoft Project 2013. 

D. Variabel Penelitian  

Variabel Penelitian yaitu Informasi atau pengumpulan data untuk 

mendukung analisis tersebut, penulis mengambil contoh sebagai studi 

kasus ialah proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga 

Wetan Kabupaten Brebes. Untuk mempermudahkan penulis perlu 

data-data yang berkaitan langsung dengan proyek tersebut : 

a) Variabel Waktu. 

Data yang mempengaruhi variabel waktu data yang berkaitan : 

1) Data cumulative progress (kurva-S) yaitu : 

(a) Jenis Kegiatan 

(b) Presentase Kegiatan 

(c) Durasi Kegiatan 

2) Rekapitulasi Perhitungan biaya proyek. 

b) Variabel Biaya  

Semua data yang mempengaruhi variabel biaya antara lain : 

1) Daftar Rencana Anggaran Biaya (RAB) penawaran 

meliputi : 

(a) Jumlah biaya normal 

(b) Durasi normal 

2) Daftar harga bahan dan upah.  

3) Analisa harga satuan pekerja. 
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E. Metode Pengumpulan Data  

Dalam penelitian ini, seringkali mendengar istilah metode 

pengumpulan data. Metode Pengumpulan data ialah tata cara atau 

teknik yang dilakukan oleh peneliti untuk memperoleh informasi yang 

dibutuhkan dalam rangka untuk mencapai tujuan penelitian. Adapun 

jenis dan metode dalam penelitian yang digunakan penulis antara lain:  

1. Data Primer, yaitu data yang didapatkan dari proyek. 

a. Observasi 

Observasi merupakan tata cara pengumpulan informasi 

yang lingkungan sebab mengaitkan bermacam aspek dalam 

penerapannya. Tata cara pengumpulan informasi observasi 

tidak cuma mengukur perilaku dari responden, tetapi pula bisa 

digunakan buat merekam bermacam fenomena yang terjalin. 

Dalam penelitian ini penulis menggunakan non participant 

observation yaitu observasi yang penelitinya tidak turut secara 

langsung dalam aktivitas ataupun proses yang lagi diamati. 

b. Wawancara 

Wawancara ialah tata cara atau usaha untuk mengumpulkan 

informasi yang bener dan terperinci dengan mengajukan 

beberapa pertanyaan yang dilakukan secara lisan pada sumber 

yang sudah ditetapkan. Wawancara termasuk dalam data 

proyek untuk mengetahui data yang mengalami keterlambatan 
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pada saat pekerjaan proyek peningkatan jalan. Wawancara ini 

dilakukan dengan pihak Kontaktor. 

c. Dokumentasi 

Dokumentasi yaitu cara yang dilakukan untuk 

mengumpulkan data yang dibutuhkan sebagai bukti dalam 

bentuk gambar, tulisan maupun foto. 

2. Data sekunder, yaitu data yang diperoleh dari sumber yang lain:  

a. Pengumpulan data proyek  

data yang perlukan untuk dianalisis  

1) Rencana Anggaran Biaya (RAB) 

2) Analisis harga satuan bahan proyek 

3) Analisa harga satuan pekerjaan 

4) Time Schedule 

b. Studi Pustaka 

Metode ini dilakukan dengan cara mengumpulkan dan 

mempelajari literatur dari bahan tertulis berupa buku - buku, 

artikel, jurnal, dan media lainya yang berhubungan dengam 

pembahasan masalah yang diangkut dalam penelitian ini. 
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F. Metode Analisa Data 

Setelah dilakukan penelitian dan data yang diperlukan sudah 

terkumpul, selanjutnya melakukan percepatan terhadap waktu dengan 

melakukan penambahan jam kerja (lembur), sehingga produktivitas 

tenaga kerja menjadi meningkat. Maka dilakukan analisis data dengan 

Microsoft Project 2013. Adapun penerapan time cost trade off .maka 

perlu dilakukan langkah-langkah sebagai berikut:  

1. Menyusun rencana jadwal dan biaya proyek (baseline). 

Langkah-langkahnya sebagai berikut :  

a) Memulai lembar kerja baru.  

Klik Start > Program > Microsoft Project 2013 

b) Masukkan tanggal mulainya pada proyek. 

Klik menu Project > Change Working Time. 

c) Menentukan kalender kerja untuk mengetahui hari kerja, 

jam kerja dan hari libur. 

1) Memilih menu File > Opion > Schedule 

2) Klik tab week start. Klik Monday 

3) Memilih menu File >Details >Set Day(S) To These 

Spicific Woeking Times. 

4) Mengisi default start time dan default end time 

d) Menyusun data kegiatan proyek dengan mengisi jenis 

kegiatan pada kolom Task Name dan waktu kegiatan pada  
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kolom Durasi. kemudian setelah kolom durasi diisi, kolom 

start dan finish akan terisi secara otomatis 

e) Mengisikan sumber daya yang terlibat dalam pekerjaan 

ialah dengan mengisikan harga satuan upah tenaga 

Resource Sheet. 

f) Memasukkan hubungan antara pekerjaan satu dengan 

lainnya pada kolom Predecessor.  

g) Masukkan biaya untuk tiap kegiatan. 

h) Masukkan Penugaskan sumber daya ke pekerjaan, database 

sumber daya tadi akan dihubungkan pada tiap pekerjaan. 

Analisis kebutuhan yang diperlukan oleh setiap pekerjaan. 

i) Menyimpan rencana jadwal dan biaya sebagai baseline  

2. Menerapkan metode time cost trade off. 

a) Penelitian ini dilakukan dengan menambahkan jam kerja 

(lembur) selama 1-3 jam untuk mempercepat penyelesaian 

durasi proyek.  

3. Penambahan jam kerja (lembur). 

Langkah-langkah untuk menentukan jam kerja (lembur) : 

a) Membagi layar Microsoft Project menjadi dua untuk 

dimasukkan data crash perencanaa berupa Gantt Chart 

View dan Task Usage. 

b) Masuk ke File > Options  
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c) Klik menu Project > Project Informasi. Pada kotak dialog 

Project information dipilih Schedule From : Project Start 

Date dan memasukkan tanggal mulainya proyek pada kotak 

Start Date. 

d) Memasukkan data kegiatan proyek dengan mengetiknya 

pada kolom Task Name dan waktu kegiatan pada kolom 

Durasi.  

e) Selanjutnya klik salah satu kegiatan yang akan di 

tambahkan tenaga kerja, dengan pilih Detail Styles > 

masukkan Actual Work (show), Actual Overtime Work 

(show), Actual Cost (show), OK. 

f) Kemudian lakukan Tracking sebelum dimasukan jam kerja 

lembur pada baris Actual Work (show), ialah cara Klik 

Task > Task Informasi General > Precent Complete 

(100%) > Durasion Sesuai Rencana Crash > OK  

g) Melakukan Proses Updating.   

G. Tahap dan Prosedur Penelitian  

Suatu penelitian harus dilaksanakan secara sistematis dan dengan 

urutan yang jelas dan teratur, sehingga akan diperoleh hasil sesuai 

dengan yang diharapkan. Karena itu, pelaksanaan penelitian ini 

dibagi dalam beberapa tahapan-tahapan sebagai berikut : 

1. Tahap I  
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Tahap Persiapan yaitu Sebelum melakukan penelitian perlu 

dilakukan studi literatur untuk memperdalam ilmu yang berkaitan 

dengan topik penelitian. Kemudian ditentukan rumusan masalah 

sampai dengan kompilasi data. 

2. Tahap II 

Tahap Pengumpulan Data adalah Data proyek yang 

diperlukan untuk pembuatan laporan meliputi: rencana anggaran 

biaya( RAB), analisa harga satuan pekerja, analisa satuan bahan 

dan time schedule.  

3. Tahap III 

Tahap Analisa data yaitu dengan Analisa percepatan dengan 

aplikasi program dan pembahasan Melakukan input data ke 

program untuk perencanaan dan update perencanaan dengan data 

pelaksanaan, dengan bantuan program Microsoft Project 2013 

dan Metode Time Cost Trande Off  ini dilakukan pengujian dari 

semua kegiatan yang dipusatkan pada kegiatan yang berada pada 

jalur kritis yang mempunyai nilai cost slope. Kemudian 

membandingkan hasil analisa percepatan yang berupa perubahan 

biaya proyek sebelum dan sesudah percepatan.  

4. Tahap IV 

Pada Tahap ini berupa kesimpulan untuk mengambil 

keputusan. Pada tahap ini, data yang telah dianalisa dibuat suatu 

kesimpulan yang berhubungan dengan tujuan penelitian. 
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H. Diagram Alur Penelitian  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Bagan Alur Penelitian 

 

 

Mulai 

Studi Lapangan dan Studi Pustaka  

Pengumpulan Data Proyek : 

1. Rencana Anggaran Biaya (RAB) 

2. Daftar harga satuan upah dan bahan 

3. Analisis harga satuan pekerjaan 

4. Time Schedule 

Analisis Time Cost Trade Off 

1. Menyusun Network Diagram  

2. Menghitung Jumlah Sumber Daya (resources) 

3. Menentukan Estimasi Durasi Dalam Microsoft 

Project 2013 

4. Menentukan Penambahan  jam  kerja ( lembur) 

dengan  metode Time Cost Trade Off 

Selesai 

Menentukan Latar Belakang Masalah 

Identifikasi dan Perumusan 

 

Kesimpulan dan Saran 
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BAB IV 

HASIL DAN PEMBAHASAN 

A. Hasil Penelitian  

Proyek yang ditinjau dalam penelitian ini adalah Proyek Peningkatan 

Jalan Kaligangsa Wetan – Randusanga Wetan. Analisis data ini dilakukan 

untuk mendapatkan data sesuai tujuan skripsi ini ialah dengan 

penambahan jam kerja (lembur) pada semua pekerjaan yang termasuk 

dalam lintasan kritis. Pada bab ini juga akan dijabarkan secara jelas dan 

rinci mengenai Analisis Optimasi Waktu dan Biaya dengan menggunakan 

metode Time Cost Trade Off melalui bantuan program Microsoft Project 

2013. 

1. Gambaran Umum Proyek Peningkatan Jalan Kaligangsa Wetan – 

Randusanga Wetan.  

Pada Proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga 

Wetan. Proyek Yang Dibangun Pada Tanggal 10 November 2020 Dan 

Proyek Ini Selesai Pada Tanggal 24 Desember 2020 dengan waktu 45 

Hari. Proyek Ini Berlokasi Di Jl. Parintis Kemerdekaan Desa 

Kaligangsa Wetan, Kabupaten Brebes, Jawa Tengah 52212, Oleh CV. 

Mulya Jaya Sebagai Kontraktor Dan CV. Papan Desain Sebagai 

Konsultan Pengawas. Proyek Ini Bernilai Rp. 1.482.125.000,00. 

2. Data Penelitian. 

Untuk mendapatkan optimasi, sebelum itu dilakukan analisis data 

proyek antara lain : 
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a) Rencana Anggaran Biaya (RAB) 

b) Time Schedule. 

Data yang didapat dari proyek akan dianalisis kembali untuk 

mendapatkan waktu penyelesaian yang lebih cepet dengan cara 

pemambahan jam kerja (lembur).  

Untuk menganalisis biaya program yang dipakai adalah Microsoft 

Excel 2007. Untuk mengetahui perubahan biaya proyek sebelum dan 

sesudah dipercepat, perlu data-data yang dimasukan Kedalam Microsoft 

Excel 2007 yaitu : 

a) Rencana Anggaran Biaya (RAB) 

b) Daftar upah pekerja 

Berikut Merupakan Data Yang Dibutuhkan Penelitian Ini Pada 

Proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga Wetan, 

Data Rencana Anggaran Biaya (Rab) dilihat pada tabel 4.1 ,Daftar 

Upah Pekerja dilihat pada tabel 4.2  

Tabel 4.1 Rekapitulasi Rencana Anggaran Biaya (RAB) 

NO URAIAN KEGIATAN JUMLAH (Rp) 

I DEVISI 1. UMUM   

1.2 Mobalitas  21.500.000,00             

1.8.(1) Manajemen Dan Keselamatan Lalu Lintas  8.425.000,00             

1.19 Keselamatan Dan Kesehatan Kerja 1.440.000,00  

II DEVISI 2. DRAINASE  

 A. PEKERJAAN TALUD KANAN KIRI JALAN 

PANJANG : 72,00 & 85,00 M, TINGGI : 1,00 

M (D= 0,50 M, B= 0,50 M) 

 

2.2.1 Pasangan Batu Dengan Mortar 164.196.202,62  

 B. PEKERJAAN PERBAIKAN TALUD KANAN  
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KIRI JALAN PANJANG : 33,00 & 17,00 M, 

TINGGI : 1,00 M (D= 0,50 M, B= 0,50 M) 

2.2.1 Pasangan Batu Dengan Mortar 33.505.849,04  

2.2.1.a Pasangan Batu Dengan Mortar (Menggunakan 

Batu Lama)  

6.557.043,19  

III DIVISI 3. PEKERJAAN TANAH DAN 

GEOSINTETIK 

 

3.1.(8) Galian Perkerasan Beraspal Tanpa Cold Miling 

Machine  

1.873.197,17  

 

 A. PEKERJAAN TALUD KANAN KIRI JALAN 

PANJANG : 72,00 & 85,00 M, TINGGI : 1,00 

M (D= 0,50 M, B= 0,50 M) 

 

3.1(1) Galian Biasa (Menggunakan Alat Berat) 1.512.445,59  

3.2.(1b) Timbunan Kembali Dari Hasil Galian   825.837,93  

 B. PEKERJAAN PERBAIKAN TALUD KANAN 

KIRI JALAN PANJANG : 33,00 & 17,00 M, 

TINGGI : 1,00 M (D= 0,50 M, B= 0,50 M) 

 

3.1(1) Galian Biasa (Mengunakan Alat Berat) 472.639,25  

3.2(1b) Timbunan Kembali Dari Hasil Galian                258.074,35  

IV DIVISI 4.PEKERJAAN PREVENTIF  

4.6(2) Lataris Kelas B (SS-B) 118.443.761,62       

V DIVISI 5. PEKERJAAN BERBUTIR   

5.1(1) Lapis Pondasi Agregat Kelas A 95.181.724,39  

5.2(2) Lapis Pondasi Agregat Kelas B 78.734.308,45 

5.3(3) Lapis Pondasi Bawah Beton Kurus 1.071.386,50  

Ls Sewa Bekisting  2.520.000,00  

Ls Pasang Bekisting 8.190.000,00  

Ls Bongkar Bekisting     2.205.000,00  

VI DIVISI 6. PERKERASAN ASPAL  

6.1.(1) Lapis Resap Pengikat- Aspal Cair/Emulsi  535.087,64 

6.1.(2a) Lapis Perekat – Aspal Cair/Emulsi 14.513.472,81  

6.7.(1) Lapis Penetrasi Macadam  7.053.356,79  

VII DIVISI 7. STRUKTUR   

7.1.(5b) Beton Struktur Fc’ 30 Mpa (Untuk Jalan Beton) 603.179.201,09  

7.3.(1) Baja Tulangan Polos- Bjtp 280 115.829.747,72  

Ls Join Sealent (Aspal) 1.270.805,76  

Ls Cat Anti Karat  502.494,45  

Ls Expansion Cap (Pvc + Solatip) 449.820,00  

Ls Polytene 125 Mikron 11.907.000,00  
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Ls Curing Compound     19.845.000,00 

Ls Concrete Cutting 5.040.000,00  

Ls Sewa Bekisting 12.600.000,00  

Ls Bongkar Bekisting  3.780.000,00  

 

 

Jumlah  1.347.387.069,86  

PPN 10% 134.738.706,99  

Total 1.482.125.776,85  

 

Dibulatkan  

  

1.482.125.000,00  

 

Tabel 4.2 Daftar Upah Pekerja dan Alat 

 

NO 

 

URAIAN 

 

KOD

E 

 

SATUAN 

 

HARGA 

 

HARGA 

PER JAM 

1. Pekerja L 01 Jam 10.428,57 73.000,00 

2. Tukang L 02 Jam 12.857,14 90.000,00 

3 Mandor L 03 Jam 14.714,29 103.000,00 

4 Operator L 04 Jam 18.000,00 126.000,00 

5 
Pembantu 

Operator 
L 05 Jam 12.857,14 90.000,00 

6. Sopir L 06 Jam 12.857,14 90.000,00 

7. Pembantu Sopir L 07 Jam 12.285,71 86.000,00 

8. Mekanik L 08 Jam 14.000,00 98.000,00 

9 
Pembantu 

Mekanik 
L 09 Jam 12.857,14 90.000,00 

10 Kepala Tukang  Jam 14.000,00 98.000,00 

11 
Tukang Las 

Kontruksi 
 Jam 14.285,71 100.000,00 
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3. Membuat Network Planning dan Menentukan Lintasan Kritis   

Berdasarkan tahap penjadwalan harus terlebih dahulu diketahui 

setiap durasi pada suatu pekerjaan proyek, dalam penelitian ini untuk 

melihat waktu setiap pekerjaan proyek dapat diketahui dengan melihat 

time schedule rencana pada proyek setelah waktu setiap pekerjaan 

diketahui, selanjutnya yaitu menentukan hubungan tiap pekerjaan, 

setelah hubungan setiap pekerjaan ini sudah ditentukan kemudian 

dimodelkan kedalam Microsoft Project 2013. 

Waktu proyek dilihat dari time schedule atau kurva S data yang 

dimasukan hanya data yang terdapat tenaga kerja saja.. 

Langkah-langkah Penjadwalan dengan menggunakan Microsoft 

Project 2013 : 

a) Memulai lembar kerja baru 

Klik Start > Program > Microsoft Project 2013 

 

 

 

 

 

 

 

Gambar 4.1 Lembar kerja baru Microsoft Project 2013 
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b) Masukkan tanggal mulainya pada proyek. 

Klik menu Project > Change Working Time. Masukkan 

tanggal dimulainya pada proyek ialah 10 November 2020. 

Langkah tersebut dapat dilihat pada gambar 4.2 dibawah. 

 

 

 

 

 

 

 

Gambar 4.2 Tanggal dimulainya pekerjaan 

c) Menentukan kalender kerja untuk mengetahui hari kerja, jam 

kerja dan hari libur. 

Pada proyek ini hari kerja dalam seminggu yaitu 7 hari, 

sedangkan pada Ms. Project secara default yaitu 6 hari kerja 

dalam seminggu. Untuk menentukannya maka dilakukan 

dengan cara berikut : 

1) Memilih menu File > Opion > Schedule 

2) Klik tab week start. Klik Monday 

3) Memilih menu File >Details >Set Day(S) To These 

Spicific Woeking Times. 
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4) Mengisi default start time : 08.00 wib dan default end 

time : 17.00 wib. Untuk lebih jelasnya dilihat paada gambar 

4.3 dibawah berikut: 

 

 

 

 

 

 

 

Gambar 4.3 Menyusun Kalender Kerja 

d) Menyusun data kegiatan proyek dengan mengisi jenis kegiatan 

pada kolom Task Name dan waktu kegiatan pada kolom 

Durasi. kemudian setelah kolom durasi diisi, kolom start dan 

finish akan terisi secara otomatis. 

 

 

 

 

 

 

 

Gambar 4.4 Memasukkan Kegiatan Kerja 
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Tabel 4.3 Daftar Pekerjaan Jalur Kritis Pada Kondisi Normal 

Kode Jenis Pekerjaan 
Durasi 

(Hari) 

2.2.1 
Pasangan Batu Dengan Mortar 

 

7 

2.2.1.a 
Galian Biasa (menggunakan alat berat) 

 

7 

3.1 (1) 
Galian Perkerasan Beraspal tanpa Cold 

Milling Machine 

2 

3.1 (1a) 
Timbunan Biasa dari hasil galian 

 

1 

4.6.(2) 
Latasir Kelas B (SS-B) 

 

5 

5.1.(1) 
Lapis Pondasi Agregat Kelas A 

 

3 

5.1.(2) 
Lapis Pondasi Agregat Kelas B 

 

6 

6.1 (1) 
Lapis Resap Pengikat - Aspal Cair/Emulsi 

 

1 

6.1 (2a) 
Lapis Perekat - Aspal Cair/Emulsi 

 

5 

6.7.(1) 
Lapis Penetrasi Macadam 

 

1 

7.1 (5b) 

Beton struktur fc’ 30 Mpa (untuk jalan 

beton) 

 

8 

7.3 (1) 
Baja Tulangan Polos-BjTP 280 

 

8 

 

e) Selanjutnya yaitu bekerja dengan sumber daya yang terlibat 

dalam pekerjaan ialah dengan memasukkan lembur kerja 

Resource Sheet. 
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Gambar 4.5 Resource Sheet 

Klik add Resource setiap kali akan memasukkan sumber daya 

yang baru. Ada tiga tipe sumber daya : 

1) Work Resource 

2) Material Resource 

3) Cost Resource 

Untuk kolom pada Accrue at : berisi jenis pembayaran dari 

resource tersebut. Ada tiga jenis ialah : 

1) Start : pembayaran dilakukan pada saat pekerjaan dimulai 

2) End : pembayaran dilakukan setlah pekerjaan selesai 

3) Prorate : pembayaran diberikan berdasarkan persentase 

pekerjaan yang telah diselesaikan. 

Maka tampilan berikut gambar 4.6 dibawah : 
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Gambar 4.6 Resource Sheet 

f) Memasukkan hubungan antara pekerjaan satu dengan lainnya 

pada kolom Predecessor. Contoh pengisian pada Predecessor : 

1) Pekerjaan galian perkerasan beraspal tanpa cold milling 

machine untuk kolom dimulai setelah dilakukannya 

pekerjaan pasangan batu dengan mortar selama 2 hari 

(Finish to Start). Maka, pada kolom predecessor pekerjaan 

beisi FS.  

 

 

 

 

 

 

 

 

 

Gambar 4.7 Predecessor 
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g) Memasukkan biaya untuk tiap kegiataan  

 

 

 

 

 

 

 

 

 

Gambar 4.8 Memasukan Biaya 

h) Penugaskan sumber daya ke pekerjaan, database sumber daya 

tadi akan dihubungkan pada tiap pekerjaan. Analisis kebutuhan 

yang diperlukan oleh setiap pekerjaan. Berikut ini yaitu daftar 

sumber daya untuk pekerjaan.  

 

 

 

 

 

 

 

Gambar 4.9 Penugasan Sumber Daya 
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i) Selanjutnya mengupdate pergerakan proyek dengan klik ganda 

pada pekerjaan yang akan update statusnya.  

 

 

 

 

 

 

Gambar 4.10 Update Pergerakan Proyek 

4. Biaya Langsung dan Biaya Tidak Langsung  

Biaya langsung (direct cost) yaitu biaya yang langsung 

berpengaruh terhadap pelaksanaan fisik proyek atau hasil akhir proyek, 

sedangkan biaya tidak langsung yaitu pengeluaran untuk manajemen 

dimana biaya ini dikeluarkan untuk dapat melancarkan proyek.  

Pada nilai koefisien bahan dan upah, peneliti menggunakan 

panduan AHSP-SNI-2020 yang kemudian akan mendapatkan total 

biaya normal bahan dan upah. Komponen tersebut tercantum kedalam 

biaya langsung (direct cost). Sebaliknya biaya tidak langsung 

merupakan hasil total biaya normal bahan serta upah ditambahkan 

dengan hasil perkalian total biaya normal serta upah dengan overhead 

serta profit. Prsentase untuk biaya tidak langsung sebesar 4,0% dari 

nilai total proyek tersebut.  
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Biaya Tidak Langsung  = 4.0 % x Rp 1.482.125.000,00 

     = Rp 59.285.000 

Biaya Tidak Langsung  = Biaya Tidak Langsung 

      Durasi Normal   

     = Rp 58.285.000 

      45  

     = Rp. 1.317.44,444/ hari 

Biaya Langsung   = biaya total rencana – biaya tidak langsung 

     = Rp. 1.482.125.000,00 - 59.285.000 

     = Rp 1.476.196.500  

5. Penerapan Metode Time Cost Trade Off  

Dalam metode Time Cost Trade Off ini dengan berubahnya durasi 

penyelesaian proyek maka akan berubah pula biaya yang akan 

dikelurkan. Apabila durasi pelaksanaan dipercepat maka biaya langsung 

proyek akan bertambah dan biaya tidak langsung akan berkurang pada 

proyek. Penerapan metode Time Cost Trade Off dalam penelitian ini 

dilakukan dengan penambahan jam kerja (lembur) selama 1-3 jam 

untuk mempercepat penyelesaian durasi proyek. 

6. Penambahan Jam Kerja (Lembur)                                           

Mengoptimalkan dilakukan dengan mengisikan data yang telah 

dimasukkan ke dalam Ms. Project 2013 untuk dibandingkan rencana 

awal dengan penambahan jam kerja (lembur).  
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Langkah- langkah Untuk Menentukan Jam Kerja (Lembur) : 

1) Membagi layar Microsoft Project menjadi dua untuk dimasukkan 

data crash perencanaa berupa Gantt Chart View dan Task 

Usage. 

2) Masuk ke File > Options  

 

Gambar 4.11 Awal Menentukan Jam Kerja Lembur 

3) Selanjutnya klik Schedule > klik tab week start Monday > klik 

tab fical year start in klik November > mengisi default start 

time : 08.00 wib dan default end time : 16:00 wib. 

4) Kemudian klik hours per day : 7 day > klik hours per week : 

49 wekk > klik per month : 30 month 

5) Setelah itu klik durasion is entered in Days > klik work is 

entered in Hours. Berikut tampilan gambar 4.12 dibawah : 
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Gambar 4.12 Menentukan Jam Kerja Lembur 

6) Selanjutnya klik salah satu kegiatan yang akan di tambahkan 

tenaga kerja, dengan pilih Detail Styles > masukkan Actual 

Work (show), Actual Overtime Work (show), Actual Cost 

(show), OK.  

7) Kemudian lakukan Tracking sebelum dimasukan jam kerja 

lembur pada baris Actual Work (show), ialah cara Klik Task > 

Task Informasi General > Precent Complete (100%) > 

Durasion Sesuai Rencana Crash > OK  

 

 

 

 

 

 

   Gambar 4.13 Menentukan Jam Kerja Lembur  
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8) Setelah itu durasi akan secara otomasis sesuai rencana dan biaya 

secara optimal otomatis juga.  

 

 

 

 

 

 

Gambar 4.14 Sesudah Penambahan Jam Kerja Lembur 

7. Analisis Perhitungan  

Analisis perhitungan didapat dari rumus atau perhitungan dengan 

cara penambahan nilai cost pekerjaan lembur pada upah per hari, 

kemudian setelah itu dikalikan dengan waktu crashing setiap 

penambahan jam kerja lembur dan akan didapatkan nilai akhir/ direct 

cost. Presentase nilai cost didapat dari dibawah : 

Tabel 4.4 Biaya Lembur Tenaga Kerja 

Pekerja 
Biaya 

Normal per 

Jam 

Overtime Cost 

Lembur 1 

jam  

Lembur 2 

jam  

Lembur 3 

jam  

Biaya 

perjam 

(Rp) 

Biaya 

perjam 

(Rp) 

Biaya 

perjam 

(Rp) 

Pekerja 10.428,57 
15.642,85 18.249,99 19.119,04 

Tukang 12.857,14 
19,285,71 22.499,99 23.571,42 

Mandor 14.714,29 
22.071 25.749,50 26.975,60 
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Operator 18.000,00 
27.000 31.500 33.000 

Pembantu 

Operator 
12.857,14 

19,285,71 22.499,99 23.571,42 

Sopir 12.857,14 
19,285,71 22.499,99 23.571,42 

Pembantu 

Sopir 
12.285,71 

18.248,56 21.499,95 22.476,18 

Mekanik 14.000,00 
21.000 24.500 25.666,60 

Pembantu 

Mekanik 
12.857,14 

19,285,71 22.499,99 23.571,42 

Kepala 

Tukang 
14.000,00 21.000 24.500 25.666,60 

Tukang Las 

Kontruksi 
14.285,71 

18.248,56 21.499,95 22.476,18 

 

Contoh perhitungan upah lembur untuk resourse name mandor ialah: 

a) Upah mandor perhari ( standart Cost) : Rp 103.000,00 

Jam Kerja Perhari : 7 jam/hari 

Biaya perjam  =      Rp 103.000,00 

       7 jam/ hari  

    

   = Rp 14.714,00 

Biaya lembur perhari untuk lembur 3 jam perhari ialah : 

Lembur 1 jam  = (Rp 14.714,00 x 1,5) 

   = Rp 22.071 

Lembur 2 jam  = (Rp 14.714,00 x 1,5) + (2 x Rp 14.714,00) 

   = Rp 51.499 
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Lembur 3 jam = (Rp14.714,00 x 1,5) +(2 x 2  Rp14.714,00) 

     = 80.927 

      Lembur perjam untuk 1 jam  = Rp 22.071 

               1 jam  

     = Rp 22.071 

Lembur perjam untuk 2 jam   = Rp 51.499 

               2 jam  

         = Rp 25.749,50 

  Lembur perjam untuk 3 jam   = Rp 80.927 

                3 jam  

         = Rp 26.975,60 

Untuk kegiatan jalur kritis yang akan dipercepat durasi percepatan 

di hitung berdasarkan penambahan jam lembur 1 jam/hari, 2 jam/hari 

dan 3 jam/hari dari durasi normal yang ada. salah satu contoh 

perhitungannya yaitu perhitungan Lapis pondasi agregat kelas B 

dibawah ini : 

1. Durasi yang bisa dicrashing dengan penambahan 1 jam lembur : 

           (Volume)      

(Prod.perjam x jam kerja ) + (∑ Jam lembur x Penurunan Prod 

x Prod .perjam 

 

Volume   = 189.00 m3  

Durasi normal  = 6 hari  

Durasi normal (jam) = 6 x 7 

    = 42 jam 
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Produktivitas jam normal  =         Volume 

            Durasi normal  

     = 189.00  = 4,5 m3/jam 

            42  

Maksimal crashing   =         189 

         (4,5x7)+(0,9x4,5) 

      = 5,3 hari  

   Maka maksimal crashing = 7 hari – 5,3 hari = 1,7 hari  

 Hasil perhitungan durasi crashing manual diatas sesuai dengan 

hasil perhitungan menggunakan Ms. Project 2013, untuk hasilnya 

dilihat pada tabel 4.5 untuk penambahan 1 jam lembur, tabel 4.6 untuk 

penambahan 2 jam lembur dan tabel 4.7 untuk penambahan 3 jam 

lembur. 

Tabel 4.5 Hasil Perhitungan Durasi Dan Biaya Dipercepat Dengan 

Penambahan 1 Jam Kerja Lembur Menggunakan Ms. Project. 

 

Jenis Pekerjaan 

Durasi 

Normal 

(Hari) 

Durasi 

Crashing 

( Hari) 

Biaya  

Normal 

(Rp) 

Biaya 

Percepatan  

(Rp) 

Pasangan Batu Dengan 

Mortar 

 

7 
6,99 164.196.202 140.744.811 

Galian Biasa 

(menggunakan alat 

berat) 

 

7 
6,43 1.512.445.59 1.397.887 

Galian Perkerasan 

Beraspal tanpa Cold 

Milling Machine 

2 
1,73 1.873.197.17 1.648.838 

Timbunan Biasa dari 

hasil galian 

 

1 
0 825.837.93 787.668 

Latasir Kelas B (SS-B) 

 

5 
4,99 118.443.761.62 124.669.619 
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LapisPondasi Agregat 

Kelas A 

 

3 
2,82 95.181.724.39 86.547.062 

LapisPondasi Agregat 

Kelas B 

 

6 
5,59 78.734.308.45 71.350.093 

Lapis Resap Pengikat - 

Aspal Cair/Emulsi 

 

1 
0 535.087.64 523.301 

Lapis Perekat - Aspal 

Cair/Emulsi 

 

5 
4,91 14.513.473.81 14.210.651 

Lapis Penetrasi 

Macadam 

 

1 
0,97 7.053.356.79 6.256.789 

Beton struktur fc’ 30 

Mpa (untuk jalan 

beton) 

 

8 
8,11 603.173.201.09 528.348.892 

Baja Tulangan Polos-

BjTP 280 

 

8 
8,03 115.829.747.72 105.294.970 

 

 

Gambar 4.15 Grafik biaya dan waktu akibat 1 jam kerja lembur  
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Tabel 4.6 Hasil Perhitungan Durasi Dan Biaya Dipercepat Dengan 

Penambahan 2 Jam Kerja Lembur Menggunakan Ms. Project. 

 

Jenis Pekerjaan 

Durasi 

Normal 

(Hari) 

Durasi 

Crashing 

( Hari) 

Biaya  

Normal 

(Rp) 

Biaya 

Percepatan  

(Rp) 

Pasangan Batu Dengan 

Mortar 

 

7 
7 164.196.202 140.801.631 

Galian Biasa 

(menggunakan alat 

berat) 

 

7 
7 1.512.445.59 1.450.314 

Galian Perkerasan 

Beraspal tanpa Cold 

Milling Machine 

2 
2 1.873.197.17 1.686.552 

Timbunan Biasa dari 

hasil galian 

 

1 
1 825.837.93 850.525 

Latasir Kelas B (SS-B) 

 

5 
5 118.443.761.62 124.707.387 

LapisPondasi Agregat 

Kelas A 

 

3 
3 95.181.724.39 86.584.770 

LapisPondasi Agregat 

Kelas B 

 

6 
6 78.734.308.45 71.390.306 

Lapis Resap Pengikat - 

Aspal Cair/Emulsi 

 

1 
1 535.087.64 586.158 

Lapis Perekat - Aspal 

Cair/Emulsi 

 

5 
5 14.513.473.81 14.248.369 

Lapis Penetrasi 

Macadam 

 

1 
1 7.053.356.79 6.294.486 

Beton struktur fc’ 30 

Mpa (untuk jalan 

beton) 

 

8 
8 603.173.201.09 548.386.581 

Baja Tulangan Polos-

BjTP 280 

 

8 
8 115.829.747.72 105.329.878 
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 Salah satu contoh perhitungannya yaitu perhitungan Lapis 

pondasi agregat kelas B dibawah ini : 

1. Durasi yang bisa dicrashing dengan penambahan 2 jam lembur: 

            (Volume)      

(Prod.perjam x jam kerja ) + (∑ Jam lembur x Penurunan Prod 

x Prod .perjam 

 Volume   = 189.00 m3  

 Durasi normal  = 6 hari  

 Durasi normal (jam) = 6 x 7 

      = 42 jam 

Produktivitas jam normal  =          Volume 

              Durasi normal  

                 = 189.00  = 4,5 m3/jam 

             42  

Maksimal crashing   =                  189 

           (4,5x7)+(0,9x4,5)+(1,7x4,5) 

                  = 4,3 hari  

 Maka maksimal crashing = 7 hari – 4,3 hari = 2,7 hari  

 

       Gambar 4.16 grafik biaya dan waktu akibat 2 jam kerja lembur 
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Tabel 4.7 Hasil Perhitungan Durasi Dan Biaya Dipercepat Dengan 

Penambahan 3 Jam Kerja Lembur Menggunakan Ms. Project. 

 

Jenis Pekerjaan 

Durasi 

Normal 

(Hari) 

Durasi 

Crashing 

( Hari) 

Biaya  

Normal 

(Rp) 

Biaya 

Percepatan  

(Rp) 

Pasangan Batu Dengan 

Mortar 

 

7 
7 164.196.202 140.839.853 

Galian Biasa 

(menggunakan alat 

berat) 

 

7 
7 1.512.445.59 1.490.173 

Galian Perkerasan 

Beraspal tanpa Cold 

Milling Machine 

2 
2 1.873.197.17 1.711.695 

Timbunan Biasa dari 

hasil galian 

 

1 
1 825.837.93 900.811 

Latasir Kelas B (SS-B) 

 

5 
5 118.443.761.62 124.737.566 

LapisPondasi Agregat 

Kelas A 

 

3 
3 95.181.724.39 86.623.307 

LapisPondasi Agregat 

Kelas B 

 

6 
6 78.734.308.45 71.430.166 

Lapis Resap Pengikat - 

Aspal Cair/Emulsi 

 

1 
1 535.087.64 636.444 

Lapis Perekat - Aspal 

Cair/Emulsi 

 

5 
5 14.513.473.81 14.273.515 

Lapis Penetrasi 

Macadam 

 

1 
1 7.053.356.79 6.319.660 

Beton struktur fc’ 30 

Mpa (untuk jalan 

beton) 

 

8 
8 603.173.201.09 548.411.749 

Baja Tulangan Polos-

BjTP 280 

 

8 
8 115.829.747.72 105.397.376 
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 Salah satu contoh perhitungannya yaitu perhitungan Lapis 

pondasi agregat kelas B dibawah ini : 

1. Durasi yang bisa dicrashing dengan penambahan 3 jam lembur: 

                    (Volume)      

(Prod.perjam x jam kerja ) + (∑ Jam lembur x Penurunan Prod x 

Prod .perjam 

 

 Volume   = 189.00 m3  

 Durasi normal  = 6 hari  

 Durasi normal (jam) = 6 x 7 

     = 42 jam 

Produktivitas jam normal  =          Volume 

              Durasi normal  

                 = 189.00  = 4,5 m3/jam 

              42  

Maksimal crashing  =          189 

         (4,5x7)+(0,9x4,5)+(1,7x4,5)+(0,7x9) 

      = 3,8 hari  

   Maka maksimal crashing = 7 hari – 3,8 hari = 3,2 hari 

 

Gambar 4.17 grafik biaya dan waktu akibat 3 jam kerja lembur 
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B. PEMBAHASAAN 

1. Analisis Optimasi Waktu Dan Biaya Dengan Penambahan Jam 

Kerja (Lembur) Menggunakan Metode Time Cost Trade Off.  

  Berikut ini adalah hasil dari penambahan jam kerja (lembur) 

dengan menggunakan Microsoft Project 2013 Pada Proyek 

Peningkatan Jalan Kaligangsa Wetan – Randusanga Wetan Kabupaten 

Brebes.  

a.  Penambahan Jam Kerja (Lembur) 1 Jam.  

Dengan penambahan 1 jam lembur dan bantuan program Microsoft 

Project 2013 maka dapat diketahui hasil waktu dan biaya sebagai 

berikut.  

Tabel 4.8 Hasil Input Waktu Dan Biaya Dari Penambahan Jam 

Kerja (Lembur) 1 Jam. 
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b.  Penambahan Jam Kerja (lembur) 2 jam. 

Dengan penambahan 2 jam lembur dan bantuan program Microsoft 

Project 2013 maka dapat diketahui hasil waktu dan biaya sebagai 

berikut.  

Tabel 4.9  Hasil Input Waktu Dan Biaya Dari Penambahan Jam 

Kerja (Lembur) 2 Jam. 
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c. Penambahan Jam Kerja (Lembur) 3 Jam  

Dengan penambahan 3 jam lembur dan bantuan program Microsoft 

Project 2013 maka dapat diketahui hasil waktu dan biaya sebagai 

berikut. 

Tabel 4.10 Hasil Input Waktu Dan Biaya Dari Penambahan Jam 

Kerja (Lembur) 3 Jam. 
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Gambar 4.18 Kurva S Pada Penambahan 1 Jam Kerja (Lembur) 

 

 

 

 

 

 

 

Gambar 4.19 Kurva S Pada Penambahan 2 Jam Kerja (Lembur) 

 

 

 

 

 

 

 

Gambar 4.20 Kurva S Pada Penambahan 3 Jam Kerja (Lembur) 
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 Hasil analisis proses percepatan proyek menunjukan bahwa 

percepatan dengan penambahan jam kerja (lembur) selama 1 jam 

menghasilkan durasi total yang lebih singkat yaitu 38 hari, jika durasi 

dibandingkan dengan penambahan jam kerja dari 2 jam dan 3 jam yaitu 38 

hari. Pada alternatif penambahan jam kerja lembur selama 1 jam memiliki 

produktivitas tenaga kerja yang lebih tinggi dari pada alternatif 

penambahan jam kerja lembur selama 2 jam dan 3 jam karena durasi 

waktu untuk menyelesaikan suatu pekerjaan lebih panjang. Akan tetapi 

alternatif dengan penambahan jam kerja lembur selama 3 jam lembur 

memiliki nilai produktivitas yang besar, semakin bertambah penambahan 

kerja lembur maka semakin berkurang produktivitas tenaga kerja untuk 

dapat menyelesaikan suatu pekerjaan.   

Tabel 4.11 Perbandingan Waktu dan Biaya 

No Lembur Kerja Durasi Optimal Biaya 

1 Normal 45 hari Rp. 1.482.125.000 

2 Lembur 1 jam 38 hari Rp. 1.210.527.713 

3 Lembur 2 jam 38 hari Rp. 1.211.101.803 

4 Lembur 3 jam 38 hari Rp. 1.211.577.304 

   

  Dari hasil analisis yang dilakukan penambahan jam kerja (lembur) 1 

jam, durasi proyek dapat dipercepat menjadi 38 hari atau lebih cepat selama 

7 hari dari durasi normal ialah selama 45 hari. Sedangkan analisis 

penambahan jam kerja lembur 2 jam dan 3 jam didapat durasi 38 hari juga. 
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Namun setelah dilakukan percepatan dengan penambahan 1 jam lembur 

didapat Rp 1.210.527.713 dari biaya normal Rp 1.482.125.000 sedangkan 

penambahan jam kerja lembur 2 jam didapat Rp  1.211.101.803  dan 

penambahan 3 jam kerja lembur didapat Rp.  1.211.577.304. maka demikian 

sesuai tujuan ialah optimasi waktu dan biaya untuk mencegah terjadinya 

keterlambatan proyek dengan memperlakukan khusus pada pekerjaan yang 

termasuk didalam jalur kritis pada tenaga kerja dengan penambahan jam 

kerja lembur dengan kenaikan biaya lembur yang tidak terlalu besar dapat 

diterapkan pada pekerjaan ini.                                                                                                            
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BAB V  

PENUTUP  

A. Kesimpulan  

Dari perhitungan optimasi waktu dan biaya dengan menggunakan 

metode time cost trade off  setelah dilakukan analisis data dan pembahasan 

dari hasil penelitian maka dapat diperoleh beberapa kesimpulan:   

1. Total durasi proyek dalam kondisi normal yaitu 45 hari. Dari hasil 

analisis pada penelitian ini, didapat total durasi penyelesaian pada 

proyek setelah dilakukan dengan alternatif penambahan jam kerja 

(lembur) selama satu jam didapat durasi penyelesaian proyek yaitu 38 

hari, penambahan jam kerja lembur dua jam didapat durasi 

penyelesaian proyek yaitu 38 hari dan penambahan jam kerja lembur 

tiga jam didapat durasi penyelesaian proyek yaitu 38 hari. Dari tiga 

penambahan jam kerja (lembur) didapatkan biaya murah ialah terdapat 

dari penambahan lembur 1 jam dengan durasi 38 hari dan biaya proyek 

sebesar Rp. 1.210.527.713. 

2. Total biaya proyek dalam kondisi normal yaitu sebesar Rp. 

1.482.125.000. Dari hasil analisis pada penelitian ini, didapat total 

biaya proyek setelah dilakukan dengan alternatif penambahan jam 

kerja (lembur) selama satu jam lembur sebesar Rp Rp. 1.210.527.713, 

penambahan jam kerja lembur selama dua jam kerja lembur sebesar 

Rp. 1.211.101.803 dan penambahan tiga jam kerja lembur sebesar Rp. 

1.211.577.304. Dari tiga penambahan jam kerja (lembur) didapatkan 
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biaya murah ialah terdapat dari penambahan lembur 1 jam dengan 

durasi 38 hari dan biaya proyek sebesar Rp. 1.210.527.713. 

B. Saran  

Berdasarkan hasil penelitian yang telah dilakukan dan kesimpulan 

diatas, penulis memberikan saran sebagai berikut : 

1. Sebaiknya dilakukan pengecekan ulang terhadap tiap pekerjaan 

terutama pada pekerjaan yang berada pada jaluk kritis agar suatu 

proyek dapat berjalan sesuai rencana dan optimal. 

2. Pembuatan hubungan antar pekerjaan dalam Microsoft Project 

hendaknya dilakukan secara teliti dan cermat agar diperoleh hasil 

analisis yang lebih akurat. 

3. Metode percepatan yang digunakan dalam penelitian ini hanya dengan 

menggunakan satu metode ialah metode time cost trade off dengan 

penambahan jam kerja lembur selama satu jam, dua jam dan tiga jam 

lembur. Maka akan lebih baik apabila ditambahakan dengan metode 

yang lainnya dengan sistem shift dan alat berat agar dapat lebih 

banyak perbandingan sehingga dapat mengetahui metode mana yang 

lebih efektif dari segi waktu dan efisien dari segi biaya. 
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Lampiran 1.  

RAB  

(Rencana Anggaran Biaya) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DINAS : DINAS PEKERJAAN UMUM 

KEGIATAN : PENINGKATAN JALAN DAN JEMBATAN (BANTUAN GUBERNUR)

NAMA PEK. : PENINGKATAN JALAN KALIGANGSA WETAN - RANDUSANGA WETAN

VOLUME : PANJANG : 446,00 M ; LEBAR : 4,00 M

KABUPATEN : BREBES

TAHUN : 2020

NO. MATA

PEMBAYARAN

a b c d e f = (d x e)

I DIVISI 1.  UMUM

1.2 Mobilisasi Ls 1,00                 21.500.000,00     21.500.000,00             

1.8.(1) Manajemen dan Keselamatan Lalu Lintas Ls 1,00                 8.425.000,00       8.425.000,00               

1.19 Keselamatan dan Kesehatan Kerja Ls 1,00                 1.440.000,00       1.440.000,00               

Jumlah Harga Pekerjaan DIVISI 1 31.365.000,00             

II DIVISI 2.  DRAINASE

A. PEKERJAAN TALUD KANAN KIRI JALAN

PANJANG : 72,00 & 85,00 M, TINGGI :  1,00 M (D= 0,50 M, B=0,50 M)

2.2.1 Pasangan Batu dengan Mortar m3 149,76              1.096.395,58       164.196.202,62           

B. PEKERJAAN PERBAIKAN TALUD KANAN KIRI JALAN

PANJANG : 33,00 & 17,00 M, TINGGI :  1,00 M (D= 0,50 M, B=0,50 M)

2.2.1 Pasangan Batu dengan Mortar m3 30,56               1.096.395,58       33.505.849,04             

2.2.1.a Pasangan Batu dengan Mortar (Menggunakan Batu Lama) m3 12,50               524.563,46          6.557.043,19               

Jumlah Harga Pekerjaan DIVISI 2 204.259.094,85           

III DIVISI 3.  PEKERJAAN TANAH DAN GEOSINTETIK

3.1 (8) Galian Perkerasan Beraspal tanpa Cold Milling Machine m3 7,50                 249.759,62          1.873.197,17               

A. PEKERJAAN TALUD KANAN KIRI JALAN

PANJANG : 72,00 & 85,00 M, TINGGI :  1,00 M (D= 0,50 M, B=0,50 M)

3.1 (1) Galian Biasa (menggunakan alat berat) m3 44,00               34.373,76            1.512.445,59               

3.2.(1b) Timbunan Kembali Dari Hasil Galian m3 14,67               56.307,13            825.837,93                 

B. PEKERJAAN PERBAIKAN TALUD KANAN KIRI JALAN

PANJANG : 33,00 & 17,00 M, TINGGI :  1,00 M (D= 0,50 M, B=0,50 M)

3.1 (1) Galian Biasa (menggunakan alat berat) m3 13,75               34.373,76            472.639,25                 

3.2.(1b) Timbunan Kembali Dari Hasil Galian m3 4,58                 56.307,13            258.074,35                 

Jumlah Harga Pekerjaan DIVISI 3 4.942.194,28               

IV DIVISI 4.  PEKERJAAN PREVENTIF

4.6.(2) Latasir Kelas B (SS-B) Ton 85,63               1.383.171,73       118.443.761,62           

Jumlah Harga Pekerjaan DIVISI 4 118.443.761,62           

V DIVISI  5. PEKERASAN BERBUTIR 

5.1.(1) Lapis Pondasi Agregat Kelas A m3 161,41              589.676,74          95.181.724,39             

5.1.(2) Lapis Pondasi Agregat Kelas B m3 189,00              416.583,64          78.734.308,45             

5.3.(3) Lapis Pondasi bawah Beton Kurus m3 -                   1.071.386,50       -                             

Ls Sewa bekisting m' 1.260,00           2.000,00              2.520.000,00               

Ls Pasang bekisting m' 1.260,00           6.500,00              8.190.000,00               

Ls Bongkar bekisting m' 1.260,00           1.750,00              2.205.000,00               

Jumlah Harga Pekerjaan DIVISI 5 186.831.032,84           

VI DIVISI 6. PERKERASAN ASPAL

6.1 (1) Lapis Resap Pengikat - Aspal Cair/Emulsi Liter 34,00               15.737,87            535.087,64                 

6.1 (2a) Lapis Perekat - Aspal Cair/Emulsi Liter 914,20              15.875,60            14.513.472,81             

6.7.(1) Lapis Penetrasi Macadam M3 4,60                 1.533.338,43       7.053.356,79               

Jumlah Harga Pekerjaan DIVISI 6 22.101.917,24             

VII DIVISI  7.  STRUKTUR

7.1 (5b) Beton struktur fc’ 30 Mpa (untuk jalan beton) m3 504,00              1.196.784,13       603.179.201,09           

7.3 (1) Baja Tulangan Polos-BjTP 280 Kg 7.932,19           14.602,50            115.829.747,72           

Ls Joint Sealent ( aspal ) Kg 132,38              9.600,00              1.270.805,76               

Ls Cat Anti Karat Kg 8,37                 60.000,00            502.494,45                 

Ls Expansion Cap ( pvc + solatip ) M1 149,94              3.000,00              449.820,00                 

Ls Polytene 125 mikron Kg 496,13              24.000,00            11.907.000,00             

Ls Curing Compound Ltr 529,20              37.500,00            19.845.000,00             

Ls Concrete Cutting M1 504,00              10.000,00            5.040.000,00               

Ls Sewa bekisting M1 1.260,00           4.000,00              5.040.000,00               

Ls Pasang bekisting M1 1.260,00           10.000,00            12.600.000,00             

Ls Bongkar bekisting M1 1.260,00           3.000,00              3.780.000,00               

Jumlah Harga Pekerjaan DIVISI 7 779.444.069,03           

VIII DIVISI 8.  REHABILITASI JEMBATAN

Jumlah Harga Pekerjaan DIVISI 8 -                             

IX DIVISI 9.  PEKERJAAN HARIAN & PEKERJAAN LAIN - LAIN

Jumlah Harga Pekerjaan DIVISI 9

X DIVISI 10.  PEKERJAAN PEMELIHARAAN KINERJA

Jumlah Harga Pekerjaan DIVISI 10

  (A)    Jumlah Harga Pekerjaan ( termasuk Biaya Umum dan Keuntungan ) 1.347.387.069,86        

  (B)    Pajak Pertambahan Nilai (PPN)= 10% 134.738.706,99           

  (C)    Jumlah Harga Pekerjaan = (A) + (B) 1.482.125.776,85        

  (D)    Jumlah Harga Pekerjaan = (C) Dibulatkan 1.482.125.000,00        

##

RENCANA ANGGARAN BIAYA

(RAB)

URAIAN SATUAN 
 PERKIRAAAN 

KUANTITAS 

 HARGA SATUAN 

(Rupiah) 

 JUMLAH HARGA 

(Rupiah) 
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Lampiran 2.      

Daftar Harga Satuan Upah Dan Bahan  

 

 

 

 

NO U R A I A N KODE SATUAN HARGA HARGA PER-HARI

I U P A H

1 Pekerja L 01 Jam 10.428,57           73.000,00                  

2 Tukang L 02 Jam 12.857,14           90.000,00                  

3 Mandor L 03 Jam 14.714,29           103.000,00                

4 Operator L 04 Jam 18.000,00           126.000,00                

5 Pembantu Operator L 05 Jam 12.857,14           90.000,00                  

6 Sopir L 06 Jam 12.857,14           90.000,00                  

7 Pembantu Sopir L 07 Jam 12.285,71           86.000,00                  

8 Mekanik L 08 Jam 14.000,00           98.000,00                  

9 Pembantu Mekanik L 09 Jam 12.857,14           90.000,00                  

10 Kepala Tukang Jam 14.000,00           98.000,00                  

11 Tukang Las Konstruksi Jam 14.285,71           100.000,00                

DAFTAR  HARGA  SATUAN  UPAH

NO U R A I A N KODE SATUAN HARGA KET.

I BAHAN DARI QUARRY

1 Pasir M.01 M3 80.000,00           Quarry

2 Batu Kali M.02 M3 80.000,00           Quarry

3 Sirtu M.16 M3 80.000,00           Quarry

4 Pasir urug M.44 M3 80.000,00           Quarry

II B A H A N

1 Pasir Agregat M 01 M3 183.420,00 Base Camp

2 Batu Agregat M 02 M3 198.490,00 Base Camp

3 Agregat Kasar M 03 M3 287.140,09 Base Camp

4 Agregat Halus M 04 M3 294.337,28 Base Camp

5 Semen/Filler M 05 KG 1.080,00 Proses/Base Camp

6 Batu Belah M 06 M3 415.000,00 Lokasi Pekerjaan

7 Aspal Curah M 10 KG 8.200,00 Base Camp

8 Kerosene / Minyak Aspal M 11 LITER 8.800,00 Base Camp

9 Semen (50 kg) M 12 ZAK 54.000,00 Base Camp

10 Besi beton/baja tulangan beton diameter 4 - 13 mm M 13 KG 10.500,00 Lokasi Pekerjaan

11 Kawat Beton M 14 KG 20.000,00 Lokasi Pekerjaan

12 Sirtu M 16 M3 150.000,00 Lokasi Pekerjaan

13 Premium M 20 LITER 6.700,00 Pertamina

14 Solar M 21 LITER 5.150,00 Pertamina

15 Solar industri M 21 A LITER 9.700,00 Pertamina

16 Minyak Pelumas M 22 LITER 40.000,00 Pertamina

17 Agregat A M 26 M3 333.033,23 Base Camp

18 Agregat B M 27 M3 213.107,35 Base Camp

19 Aspal Drum M 31 KG 9.600,00 Base Camp

20 Agregat Pecah Mesin 0-5 mm M91 M3 294.337,28 Base Camp

21 Agregat Pecah Mesin 5-10 & 10-20 mm M92 M3 287.140,09 Base Camp

22 Agregat Pecah Mesin 20-30 mm M93 M3 287.140,09 Base Camp

23 Pasir Pasang / Beton M3 225.000,00 Lokasi Pekerjaan

24 Air Ltr 50,00 Lokasi Pekerjaan

25 Kayu Bakar M3 330.000,00 Lokasi Pekerjaan

26 Joint Sealent ( aspal ) Kg 9.600,00 Lokasi Pekerjaan

27 Cat Anti Karat Kg 60.000,00 Lokasi Pekerjaan

28 Expansion Cap ( pvc + solatip ) M1 3.000,00 Lokasi Pekerjaan

29 Polytene 125 mikron Kg 24.000,00 Lokasi Pekerjaan

30 Curing Compound Ltr 40.000,00 Lokasi Pekerjaan

31 Concrete Cutting m' 10.000,00 Lokasi Pekerjaan

32 Sewa bekisting M1 4.000,00 Lokasi Pekerjaan

33 Pasang bekisting M1 13.000,00 Lokasi Pekerjaan

34 Bongkar bekisting M1 3.500,00 Lokasi Pekerjaan

35 Super Plastisizer max 0,3% sm kg 35.000,00 Lokasi Pekerjaan

DAFTAR  HARGA  SATUAN  BAHAN
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Lampiran 3.  

Time Schedule 
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Lampiran 4.  

Daftar Analisa Harga Satuan Pekerjaan 

 

 

 

 

 

   

 

 

 

HARGA SATUAN

(Rp.)

ANALISA EI

DIVISI 1. UMUM

II. NON DANA ALOKASI KHUSUS (NON DAK)

1 Mobilisasi 1.2 Ls 21.500.000,00          

2 Manajemen dan Keselamatan Lalu Lintas 1.8.(1) Ls 8.425.000,00            

3 Keselamatan dan Kesehatan Kerja 1.19 Ls 1.440.000,00            

DIVISI 2. DRAINASE

1 Pasangan Batu dengan Mortar 2.2.1 M3 1.096.395,58            

2 Pasangan Batu Kali dengan Mortar (Menggunakan Batu Lama) 2.2.1.a M3 524.563,46               

DIVISI  3.  PEKERJAAN  TANAH DAN GEOSINTETIK

1 Galian Biasa (menggunakan alat berat) 3.1 (1) M3 34.373,76                 

2 Galian Biasa (manual) 3.1 (1a) M3 56.627,74                 

4 Galian Perkerasan Beraspal tanpa Cold Milling Machine 3.1 (8) M3 249.759,62               

7 Timbunan Biasa dari hasil galian 3.2.(1b) M3 56.307,13                 

8 Timbunan Kembali Dari Hasil Galian 3.2.(2b) M3 35.663,49                 

9 Timbunan Pilihan Berbutir (diukur diatas bak truk) 3.2.(3a) M3 223.637,29               

DIVISI  4.  PEKERJAAN PREVENTIF

1 Latasir Kelas B (SS-B) 4.6.(2) Ton 1.383.171,73            

2 Latasir Kelas B (SS-B) Manual 4.6.(2a) Ton 1.248.345,89            

DIVISI  5.  PERKERASAN  BERBUTIR

1 Lapis Pondasi Agregat Kelas A 5.1.(1) M3 589.676,74               

2 Lapis Pondasi Agregat Kelas B 5.1.(2) M3 416.583,64               

3 Lapis Pondasi bawah Beton Kurus 5.3.(3) M3 1.071.386,50            

DIVISI  6.  PERKERASAN  ASPAL

1 Lapis Resap Pengikat - Aspal Cair/Emulsi 6.1 (1) Liter 15.737,87                 

2 Lapis Perekat - Aspal Cair/Emulsi 6.1 (2a) Liter 15.875,60                 

3 Lapis Penetrasi Macadam 6.7.(1) M3 1.533.338,43            

DIVISI  7.  STRUKTUR

1 Beton struktur fc’ 30 Mpa (untuk jalan beton) 7.1 (5b) M3 1.196.784,13            

2 Baja Tulangan Polos-BjTP 280 7.3 (1) Kg 14.602,50                 

DAFTAR HARGA SATUAN PEKERJAAN 

NO ANALISA PEKERJAAN KODE SATUAN
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Lampiran 6.  

Hasil Output Microsoft Project 2013 

A. Hasil Output Penambahan Jam Kerja (Lembur) 1 Jam.  
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ID Resource Name % Comp. Work Overtime Baseline Variance Actual Remaining  
1 TANDEM ROLLER 6-8 T 0% 22 days 0 days 0.13 days 21.88 days 0 days 22 days 

2 WATER TANKER 3000- 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

3 ASPHALT FINISHER 100% 4.3 Unit 0 days 4.3 Unit 0 Unit 4.3 Unit 0 Unit 

4 TIRE ROLLER 8-10 T. 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

5 ASPHALT SPRAYER 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 
6 COMPRESSOR 4000-65 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

7 EXCAVATOR 80 - 140 M 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

8 Test Kuat Tarik Besi 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

9 Ekstraksi Aspal 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

10 Uji Kuat Tekan Beton 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

11 Papan nama proyek 100% 2 Set 0 days 2 Set 0 Set 2 Set 0 Set 

12 Demobilisasi 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

13 Sewa Rambu Peringatan 0%  0 days  0   

14 Sewa Rambu Peringatan 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

15 Sewa Traffic Cone 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

16 Pita Pengaman 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

17 Sewa Lampu Sementara 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

18 Sewa Tongkat Pengatur 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

19 Sewa Lampu Putar (Rota 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

20 Sewa Peralatan komunik 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

21 Alat Bantu 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

22 Pekerja (Flagman) 0% 0 days 0 days 0 days 0 days 0 days 0 days 

23 Koordinator / Pengatur 0% 0 days 0 days 0 days 0 days 0 days 0 days 

24 Spanduk (Banner) 100% 2 Lbr 0 days 2 Lbr 0 Lbr 2 Lbr 0 Lbr 

25 Papan Informasi K3 100% 1 Buah 0 days 1 Buah 0 Buah 1 Buah 0 Buah 

26 Sewa Topi pelindung (Sa 100% 10 Buah 0 days 10 Buah 0 Buah 10 Buah 0 Buah 

27 Pelindung pernafasan da 100% 2 Box 0 days 2 Box 0 Box 2 Box 0 Box 
28 Sarung tangan (Safety gl 100% 10 Psg 0 days 10 Psg 0 Psg 10 Psg 0 Psg 

29 Sewa Sepatu keselamata 100% 10 Psg 0 days 10 Psg 0 Psg 10 Psg 0 Psg 

30 Rompi keselamatan (Saf 100% 10 Buah 0 days 10 Buah 0 Buah 10 Buah 0 Buah 

31 Peralatan P3K (Kotak P3 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

32 Pekerja 100% 408.08 days 1.63 days 408.08 days 0 days 408.08 days 0 days 

33 Tukang Batu 100% 42.13 days 0.25 days 42.13 days 0 days 42.13 days 0 days 

34 Mandor 100% 98.46 days 1.5 days 98.46 days 0 days 98.46 days 0 days 

35 Batu 100% 179.71 0 days 179.71 0 179.71 0 

36 Semen 100% 209,578.75 0 days 209,578.75 0 209,578.75 0 

37 Pasir 100% 72 0 days 72 0 72 0 

38 Concrete Mixer 100% 60.14 0 days 60.14 0 60.14 0 

39 Concrete Cutter 0%  0 days  0   

40 Jack Hammer + Compre 100% 15.06 0 days 15.06 0 15.06 0 

41 Dump Truck 100% 80.45 0 days 80.45 0 80.45 0 

42 Excavator 100% 0.69 0 days 0.69 0 0.69 0 

43 Dumptruck 100% 4.13 0 days 4.13 0 4.13 0 

44 Mototr Grader 100% 0.03 0 days 0.03 0 0.03 0 

45 Vibrator Roller 100% 0.06 0 days 0.06 0 0.06 0 

46 Water Tank Truck 100% 19.75 0 days 19.75 0 19.75 0 

47 Pasir Kasar 100% 8.08 M3 0 days 8.08 M3 0 M3 8.08 M3 0 M3 

48 Pasir Halus 100% 47.96 M3 0 days 47.96 M3 0 M3 47.96 M3 0 M3 

49 Aspal 100% 8,320.54 Kg 0 days 8,320.54 Kg 0 Kg 8,320.54 Kg 0 Kg 

50 Wheel Loader 100% 3.82 0 days 3.82 0 3.82 0 

51 AMP 100% 1.72 0 days 1.72 0 1.72 0 

52 Genset 100% 1.72 0 days 1.72 0 1.72 0 

53 Dump Truck 0% 0 0 days 0 0 0 0 

54 Asphalt Finisher 0% 0 0 days 0 0 0 0 

55 Tandem Roller 100% 21.7 0 days 21.7 0 21.7 0 

56 P. Tyre Roller 100% 2.04 0 days 2.04 0 2.04 0 

57 Agregat A 100% 208.06 0 days 208.06 0 208.06 0 

58 Agregat B 100% 240.3 0 days 240.3 0 240.3 0 

59 Wheel Loader 0% 0 0 days 0 0 0 0 

60 Dump Truck 6 - 8 M3 100% 52.2 0 days 52.2 0 52.2 0 

61 Motor Grader 100% 0.26 0 days 0.26 0 0.26 0 

62 Vibratory Roller 100% 3.93 0 days 3.93 0 3.93 0 

63 Sewa bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 

64 Pasang bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 

65 Bongkar bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 
66 Aspal Emulsi CSS-1 100% 58.37 Liter 0 days 58.37 Liter 0 Liter 58.37 Liter 0 Liter 
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ID Resource Name % Comp. Work Overtime Baseline Variance Actual Remaining  
67 Asphalt Distributor 100% 0.26 0 days 0.26 0 0.26 0 

68 Air Compressor 100% 0.94 0 days 0.94 0 0.94 0 

69 Aspal Emulsi 100% 1,569.41 0 days 1,569.41 0 1,569.41 0 

70 Power Broom 100% 0.73 0 days 0.73 0 0.73 0 

71 Agregat Kasar 100% 412.56 0 days 412.56 0 412.56 0 
72 Agregat Pengunci 100% 1.66 0 days 1.66 0 1.66 0 

73 Agregat Penutup 100% 0.93 0 days 0.93 0 0.93 0 

74 Aspal 0% 0 0 days 0 0 0 0 

75 Kayu bakar 100% 0.24 0 days 0.24 0 0.24 0 

76 Pasir Pasang / Beton 100% 288.19 0 days 288.19 0 288.19 0 

77 Air 100% 96,037.2 0 days 96,037.2 0 96,037.2 0 

78 platizier 100% 524.51 0 days 524.51 0 524.51 0 

79 Concrete Mixing Plant 100% 25.3 0 days 25.3 0 25.3 0 

80 Truck Mixer 100% 177.21 0 days 177.21 0 177.21 0 

81 Concrete Vibrator 100% 151.8 0 days 151.8 0 151.8 0 

82 Water Tank Truck 0% 0 0 days 0 0 0 0 

83 Baja Tulangan Polos BjT 100% 8,170.16 Kg 0 days 8,170.16 Kg 0 Kg 8,170.16 Kg 0 Kg 

84 Kawat Beton 100% 158.64 M3 0 days 158.64 M3 0 M3 158.64 M3 0 M3 

85 Joint Sealent ( aspal ) 100% 132.38 0 days 132.38 0 132.38 0 

86 Cat Anti Karat 100% 8.37 0 days 8.37 0 8.37 0 

87 Expansion Cap ( pvc + so 100% 149.94 0 days 149.94 0 149.94 0 

88 Polytene 125 mikron 100% 496.13 0 days 496.13 0 496.13 0 

89 Curing Compound 100% 529.2 0 days 529.2 0 529.2 0 

90 Concrete Cutting 100% 504 0 days 504 0 504 0 

91 Sewa bekisting1 100% 1,260 0 days 1,260 0 1,260 0 

92 Pasang bekisting1 100% 1,260 0 days 1,260 0 1,260 0 
93 Bongkar bekisting1 100% 1,260 0 days 1,260 0 1,260 0 

 

 Page 1  

ID Task Name Work Baseline Variance Actual Remaining % W. Comp. 2020 December 2020 
6 8     10   12    14   16   18    20   22    24   26   28  30    2 4 6 8 1 

1 PENINGKATAN JALAN K 570.67 days 548.67 days 22 days 548.67 days 22 days 96% 

  
 

 
WAT 

 
 
 
 
 

 
12 Ekstraksi Aspal 

 
 

 
0 days 

 
 

 
0 days 

 
 

 
0 days 

 
 

 
0 days 

 
 

 
0 days 

 
 

 
100% 

 
EXCAVATOR 80 - 140 M3[1 Unit] 

Test Kuat Tarik Besi[1 Set] 

13 Uji Kuat Tekan B 0 days 0 days 0 days 0 days 0 days 100% Uji 

14 Papan nama pro 

15 Demobilisasi 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

Papan nama proyek[2 Set] 

16 Manajemen dan Ke 108 days 108 days 0 days 108 days 0 days 100% 

17 Peralatan 

18 Tenaga 

19 Keselamatan dan 

0 days 

108 days 

0 days 

0 days 

108 days 

0 days 

0 days 

0 days 

0 days 

0 days 

108 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 

23 DIVISI 2. DRAINASE 104.86 days 104.86 days 0 days 104.86 days 0 days 100% 

24 Pasangan Batu den 

25 DIVISI 3. PEKERJAA 

26 Galian Perkerasan 

27 Galian Biasa (meng 

28 Timbunan Kembali 

29 DIVISI 4. PEKERJAA 

30 Latasir Kelas B (SS 

31 DIVISI 5. PEKERASA 

32 Lapis Pondasi Agre 

33 Lapis Pondasi Agre 

34 Sewa bekisting 

35 Pasang bekisting 

36 Bongkar bekisting 

37 DIVISI 6. PERKERAS 

104.86 days 

3.3 days 

1.4 days 

1.65 days 

0.25 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

15.93 days 

104.86 days 

3.3 days 

1.4 days 

1.65 days 

0.25 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

15.93 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

104.86 days 

3.3 days 

1.4 days 

1.65 days 

0.25 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

15.93 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

Batu[179.71],Semen[34,744.32],Pa 

 
Pekerja[0.47],Mandor[0 

Pekerja[0.22],Mandor[0.01],Excavator[0.62],Dum 

Pekerja[0.12],Mandor[0.03],Dum 

 
 
 

Pekerja[0.7],Mandor[0.09], 

Pekerja[0.31],Mando 

Sewa bekistin 

Pasang bekist 

Bongkar beki 

 

 
 
 

 
Project: Project 1. 
Date: 7/22/2021 

Task 

Split 

Milestone 

Summary 

Project Summary 

External Tasks 

External Milestone 

Inactive Milestone 

Inactive Summary 

Manual Task 

Duration-only 

Manual Summary Rollup 

Manual Summary 

Start-only 

Finish-only 

External Tasks 

External Milestone 

Critical 

Critical Split 

Progress 

Deadline 

2 UMUM 130 days 108 days 22 days 108 days 22 days 83% 

3 Mobilisasi 22 days 0 days 22 days 0 days 22 days 0% 

4 TANDEM ROLL 22 days 0 days 22 days 0 days 22 days 0% 

5 WATER TANKE 0 days 0 days 0 days 0 days 0 days 100% 

6 ASPHALT FINIS 0 days 0 days 0 days 0 days 0 days 100% 

7 TIRE ROLLER 8 0 days 0 days 0 days 0 days 0 days 100% 

8 ASPHALT SPR 0 days 0 days 0 days 0 days 0 days 100% 

9 COMPRESSOR 0 days 0 days 0 days 0 days 0 days 100% 

10 EXCAVATOR 8 0 days 0 days 0 days 0 days 0 days 100% 

11 Test Kuat Tarik 0 days 0 days 0 days 0 days 0 days 100% 
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ID Task Name Work Baseline Variance Actual Remaining % W. Comp. 2020 December 2020 
6 8     10   12    14   16   18    20   22    24   26   28  30    2 4 6 8 1 

38 Lapis Resap Pengik 

39 Lapis Perekat - Asp 

0.25 days 

10.95 days 

0.25 days 

10.95 days 

0 days 

0 days 

0.25 days 

10.95 days 

0 days 

0 days 

100% 

100% 

40 Lapis Penetrasi Mac 4.73 days 

41 DIVISI 7. STRUKTUR 217.6 days 

4.73 days 

217.6 days 

0 days 

0 days 

4.73 days 

217.6 days 

0 days 

0 days 

100% 

100% 

42 Beton struktur fc’ 30 

43 Baja Tulangan Polo 

44 Joint Sealent ( aspa 

45 Cat Anti Karat 

46 Expansion Cap ( pv 

47 Polytene 125 mikro 

48 Curing Compound 

49 Concrete Cutting 

50 Sewa bekisting 

51 Pasang bekisting 

52 Bongkar bekisting 

44.24 days 

173.36 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

44.24 days 

173.36 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

44.24 days 

173.36 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

S 

Peke 

 
Cat A 

Expa 

Polyt 

Curin 
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Sewa 

Pasa 

Bong 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Project: Project 1. 
Date: 7/22/2021 

Task 

Split 

Milestone 

Summary 

Project Summary 

External Tasks 

External Milestone 

Inactive Milestone 

Inactive Summary 

Manual Task 

Duration-only 

Manual Summary Rollup 

Manual Summary 

Start-only 

Finish-only 

External Tasks 

External Milestone 

Critical 

Critical Split 

Progress 

Deadline 

January 2021 February 2021 March 2021 
10 12 14 16 18 20 22 24 26 28 30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29   31    2 4 6 8 10 12 14 16 18 20 22   24   26   28    2 4 6 

 
 
 

TANDEM ROLLER 6-8 T. 

ATER TANKER 3000-4500 L.[1 Unit] 

ASPHALT FINISHER[1 Unit] 

TIRE ROLLER 8-10 T.[1 Unit] 

ASPHALT SPRAYER[1 Unit] 

COMPRESSOR 4000-6500 L\M[1 Unit] 
 

et] 

Ekstraksi Aspal[1 Set] 

Uji Kuat Tekan Beton[1 Set] 
 

Demobilisasi[1 LS] 
 

Sewa Rambu Peringatan dengan Kata-Kata[Rp200,000],Sewa Rambu Peringatan Pekerjaan di Jalan[2 Buah],Sewa Traffic Cone[4 Buah],Pita Pengaman [4 Buah],Sewa Lampu Se 

Pekerja[2],Mandor 

 
 

],Pasir[72],Concrete Mixer[60.14],Pekerja[12.87],Mandor[1.07],Tukang Batu[12.87] 

 
r[0.23],Concrete Cutter[Rp68,745],Jack Hammer + Compressor[15.06],Dump Truck[2.43] 

umptruck[4.13] 

Dump Truck[1.79],Excavator[0.07],Mototr Grader[0.03],Vibrator Roller[0.06],Water Tank Truck[0.5] 
 

Pasir Kasar[8.08 M3],Pasir Halus[47.96 M3],Aspal[7,937.9 Kg],Wheel Loader[0.75],AMP[1.72],Genset[1.72],Dump Truck[14.43],ASPHALT FINISHER[3.3 Unit],Tandem Roller[21.49 

 
9],Agregat A[208.06],Wheel Loader[1.41],Dump Truck 6 - 8 M3[52.2],Motor Grader[0],Vibratory Roller[2.1] 

ndor[0.04],Agregat B[240.3],Wheel Loader[1.63],Dump Truck[61.05],Motor Grader[0.26],Vibratory Roller[1.83] 

sting[1,260 m'] 

kisting[1,260 m'] 

ekisting[1,260 m'] 

 
 
 
 
 

Project: Project 1.  
Date: 7/22/2021 

 
Task 

Split 

Milestone 

Summary 

Project Summary 

External Tasks 

External Milestone 

 
Inactive Milestone 

Inactive Summary 

Manual Task 

Duration-only 

Manual Summary Rollup 

Manual Summary 

Start-only 

 
Finish-only 

External Tasks 

External Milestone 

Critical 

Critical Split 

Progress 

Deadline 
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January 2021 February 2021 March 2021 
10 12 14 16 18 20 22 24 26 28 30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29   31    2 4 6 8 10 12 14 16 18 20 22   24   26   28    2 4 6 

Pekerja[0.05],Mandor[0.02],Aspal Emulsi CSS-1 [58.37 Liter],Asphalt Distributor[0.01],Air Compressor[0.02] 

Pekerja[1.46],Mandor[0.73],Aspal Emulsi[1,569.41],Asphalt Distributor[0.18],Air Compressor[0.92],Power Broom[0.73] 

Pekerja[4.3],Mandor[0.43],Agregat Kasar[5.33],Agregat Pengunci[1.66],Agregat Penutup[0.93],Dump Truck[0.75],Tandem Roller[0.21],Asphalt Distributor[0.07],Aspal[382.64 Kg],Kayu bakar 
 

Semen[174,834.43],Pasir Pasang / Beton[288.19],Agregat Kasar[407.23],Air[96,037.2],platizier[524.51],Concrete Mixing Plant[25.3],Truck Mixer[177.21],Concrete Vibrator[151.8],Water Tank Truc 

ekerja[13.01],Tukang Batu[4.33],Mandor[4.33],Baja Tulangan Polos BjTP 280[8,170.16 Kg],Kawat Beton[158.64 M3] 

Joint Sealent ( aspal )[132.38] 

at Anti Karat[8.37] 

xpansion Cap ( pvc + solatip )[149.94] 

olytene 125 mikron[496.13] 

uring Compound[529.2] 

Concrete Cutting[504] 

ewa bekisting1[1,260] 

asang bekisting1[1,260] 

ongkar bekisting1[1,260] 
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Sementara[2 Buah],Sewa Tongkat Pengatur Lalu Lin 

 
 
 
 
 
 
 
 
 

 
49],P. Tyre Roller[2.04],Pekerja[17.19],Mandor[1.72] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

as (Warning Light Stick)[4 Buah],Sewa Lampu ... 
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 April 2021 May 2021 June 20 
8 10 12 14 16 18 20 22 24 26 28 30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31 2 

 

 
ar [0.24],Wheel Loader[0.03] 

uck[19.25],Pekerja[4.74],Mandor[0.79] 
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 Split       Inactive Summary     External Tasks  
 

         

 
Project: Project 1.  
Date: 7/22/2021 

Milestone 

Summary 

 
 

     Manual Task 

Duration-only 

    External Milestone 

Critical 

          

 Project Summary       Manual Summary Rollup     Critical Split           

 External Tasks       Manual Summary     Progress           

 External Milestone  
 

     Start-only     Deadline  
 

         

Page 6 

 



100 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

November 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

      1 

       

2 3 4 5 6 7 8 

       

9 10 11 12 13 14 15 

 Papan nama proyek, 1 d  EX CAVATOR 80 - 140 M3, 7 d ays  

16 17 18 19 20 21 22 

EXCAVATOR 80 - 140 M3, 7 days      

23 24 25 26 27 28 29 

   TA NDEM ROLLER 6-8 T., 22 d ays  

  WATER TANKER 3 000-4500 L., 12 days  

  Test Kuat Tarik Besi, 1 d   

Uji Kuat Tekan Beton, 3 days  

  

30       

  TA NDEM ROLLER 6-8 T., 22 d ays   

  WATE R TANKER 3000-4500 L., 1 

 
 

Uji Kuat Tekan Beton, 3 days 

2 days   

      

      

December 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

 1 2 3 4 5 6 

  TA NDEM ROLLER 6-8 T., 22 d ays   

  WATE R TANKER 3000-4500 L., 1 

 
 

Uji Kuat Tekan Beton, 3 days 

 
 

Peralatan, 36 days 

2 days   

      

      

7 8 9 10 11 12 13 

  TA NDEM ROLLER 6-8 T., 22 d ays   

WATER TANKER 3000-4     ASPHALT FINISHER, 6 day s 

  
Beton, 3 days 

   
 

COM 

TIRE ROLLER 8-10 T., 6 day 

ASPHALT SPRAYER, 6 day 

PRESSOR 4000-6500 L\M, 

s 

s 

6 days 

Uji Kuat Tekan 

 

   Peralatan, 36 days    

14 15 16 17 18 19 20 

  TA NDEM ROLLER 6-8 T., 22 d ays   

A SPHALT FINISHER, 6 days  Ekstraksi Aspal, 1 day    

T IRE ROLLER 8-10 T., 6 day s Demobilisasi, 1 day    

A SPHALT SPRAYER, 6 days      

COMP RESSOR 4000-6500 L\M, 6 days     

 Peralatan, 36 days      

21 22 23 24 25 26 27 

 TANDEM ROLLE R 6-8 T., 22 days     

28 29 30 31    
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B. Hasil Output Penambahan Jam Kerja (Lembur) 2 Jam 
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ID  Resource Name Type Material Label Initials Group Max. Units Std. Rate Ovt. Rate  

66  Aspal Emulsi CSS-1 Material Liter A   Rp8,200   

67  Asphalt Distributor Material  A   Rp303,200   

68  Air Compressor Material  A   Rp196,000   

69  Aspal Emulsi Material  A   Rp8,200   

70  Power Broom Material  P   Rp75,800   

71  Agregat Kasar Material  A   Rp287,140   

72  Agregat Pengunci Material  A   Rp287,140   

 

ID  Resource Name Type Material Label Initials Group Max. Units Std. Rate Ovt. Rate  

1  TANDEM ROLLER 6-8 T Material Unit T   Rp3,000,000   

2  WATER TANKER 3000- Material Unit W   Rp1,000,000   

3  ASPHALT FINISHER Material Unit A   Rp3,000,000   

4  TIRE ROLLER 8-10 T. Material Unit T   Rp3,000,000   

5  ASPHALT SPRAYER Material Unit A   Rp500,000   

6  COMPRESSOR 4000-65 Material Unit C   Rp500,000   

7  EXCAVATOR 80 - 140 M Material Unit E   Rp3,000,000   

8  Test Kuat Tarik Besi Material Set T   Rp1,500,000   

9  Ekstraksi Aspal Material Set E   Rp1,500,000   

10  Uji Kuat Tekan Beton Material Set U   Rp2,500,000   

11  Papan nama proyek Material Set P   Rp250,000   

12  Demobilisasi Material LS D   Rp1,500,000   

13  Sewa Rambu Peringatan Cost  S      

14  Sewa Rambu Peringatan Material Buah S   Rp100,000   

15  Sewa Traffic Cone Material Buah S   Rp75,000   

16  Pita Pengaman Material Buah P   Rp75,000   

17  Sewa Lampu Sementara Material Buah S   Rp150,000   

18  Sewa Tongkat Pengatur Material Buah S   Rp50,000   

19  Sewa Lampu Putar (Rota Material Buah S   Rp100,000   

20  Sewa Peralatan komunik Material Set S   Rp250,000   

21  Alat Bantu Material Ls A   Rp250,000   

22  Pekerja (Flagman) Work  P  2 Rp10,429/hr Rp20,854/hr  

23  Koordinator / Pengatur Work  K  1 Rp14,714/hr Rp29,428/hr  
24  Spanduk (Banner) Material Lbr S   Rp150,000   

25  Papan Informasi K3 Material Buah P   Rp150,000   

26  Sewa Topi pelindung (Sa Material Buah S   Rp10,000   

27  Pelindung pernafasan da Material Box P   Rp20,000   

28  Sarung tangan (Safety gl Material Psg S   Rp5,000   

29  Sewa Sepatu keselamata Material Psg S   Rp50,000   

30  Rompi keselamatan (Saf Material Buah R   Rp15,000   

31  Peralatan P3K (Kotak P3 Material Ls P   Rp150,000   

32  Pekerja Work  P  1 Rp10,429/hr Rp20,858/hr  

33  Tukang Batu Work  T  723 Rp12,857/hr Rp25,740/hr  

34  Mandor Work  M  335 Rp14,714/hr Rp29,428/hr  

35  Batu Material  B   Rp415,000   

36  Semen Material  S   Rp1,080   

37  Pasir Material  P   Rp225,000   

38  Concrete Mixer Material  C   Rp54,400   

39  Concrete Cutter Cost  C      

40  Jack Hammer + Compre Material  J   Rp46,400   

41  Dump Truck Material  D   Rp302,800   

42  Excavator Material  E   Rp479,000   

43  Dumptruck Material  D   Rp229,100   

44  Mototr Grader Material  M   Rp670,700   

45  Vibrator Roller Material  V   Rp356,500   

46  Water Tank Truck Material  W   Rp265,800   

47  Pasir Kasar Material M3 P   Rp183,420   

48  Pasir Halus Material M3 P   Rp294,337   

49  Aspal Material Kg A   Rp8,200   

50  Wheel Loader Material  W   Rp532,400   

51  AMP Material  A   Rp6,668,800   

52  Genset Material  G   Rp318,100   

53  Dump Truck Material  D   Rp229,100   

54  Asphalt Finisher Material  A   Rp592,300   

55  Tandem Roller Material  T   Rp378,800   

56  P. Tyre Roller Material  P   Rp469,700   

57  Agregat A Material  A   Rp333,033   

58  Agregat B Material  A   Rp213,107   

59  Wheel Loader Material  W   Rp532,400   

60  Dump Truck 6 - 8 M3 Material  D   Rp302,800   

61  Motor Grader Material  M   Rp670,700   

62  Vibratory Roller Material  V   Rp229,100   

63  Sewa bekisting Material m' S   Rp2,000   

64  Pasang bekisting Material m' P   Rp6,500   

65  Bongkar bekisting Material m' B   Rp1,750   
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73  Agregat Penutup Material  A   Rp287,140   

74  Aspal Material  A   Rp8,200   

75  Kayu bakar Material  K   Rp330,000   

76  Pasir Pasang / Beton Material  P   Rp225,000   

77  Air Material  A   Rp50   

78  platizier Material  p   Rp35,000   

79  Concrete Mixing Plant Material  C   Rp610,900   

80  Truck Mixer Material  T   Rp693,900   

81  Concrete Vibrator Material  C   Rp47,000   

82  Water Tank Truck Material  W   Rp265,800   

83  Baja Tulangan Polos BjT Material Kg B   Rp10,500   

84  Kawat Beton Material M3 K   Rp20,000   

85  Joint Sealent ( aspal ) Material  J   Rp9,600   

86  Cat Anti Karat Material  C   Rp60,000   

87  Expansion Cap ( pvc + so Material  E   Rp3,000   

88  Polytene 125 mikron Material  P   Rp24,000   

89  Curing Compound Material  C   Rp37,500   

90  Concrete Cutting Material  C   Rp10,000   

91  Sewa bekisting1 Material  S   Rp4,000   

92  Pasang bekisting1 Material  P   Rp10,000   

93  Bongkar bekisting1 Material  B   Rp3,000   

 

 

 

     

 

ID Task Name Work Baseline Variance Actual Remaining % W. Comp. 20 December 202 
6 8 10    12     14    16     18    20     22    24     26  28    30 2 4 

1 PENINGKATAN JALAN K 549.32 days 0 days 549.32 days 548.34 days 0.97 days 99% 

2 UMUM 

3 Mobilisasi 

108 days 

0 days 

38 days 

38 days 

70 days 

-38 days 

108 days 

0 days 

0 days 

0 days 

100% 

100% 

16 Manajemen dan Ke 108 days 9 days 99 days 108 days 0 days 100% 

17 Peralatan 

18 Tenaga 

19 Keselamatan dan 

0 days 

108 days 

0 days 

12 days 

6 days 

6 days 

-12 days 

102 days 

-6 days 

0 days 

108 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 

20 Sosialisasi dan P 0 days 6 days -6 days 0 days 0 days 100% Spanduk (Banner)[2 Lbr],Papan Informasi K3[1 Buah] 

21 Alat Pelindung K 

22 Fasilitas sarana 

0 days 

0 days 

6 days 

7 days 

-6 days 

-7 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

23 DIVISI 2. DRAINASE 

24 Pasangan Batu den 

104.86 days 

104.86 days 

1 day 

1 day 

103.86 days 104.86 days 

103.86 days  104.86 days 

0 days 

0 days 

100% 

100% 

 
Batu[179.71],Semen[34,744. 

25 DIVISI 3. PEKERJAA 

26 Galian Perkerasan 

27 Galian Biasa (meng 

28 Timbunan Kembali 

29 DIVISI 4. PEKERJAA 

30 Latasir Kelas B (SS 

31 DIVISI 5. PEKERASA 

32 Lapis Pondasi Agre 

33 Lapis Pondasi Agre 

34 Sewa bekisting 

35 Pasang bekisting 

36 Bongkar bekisting 

37 DIVISI 6. PERKERAS 

38 Lapis Resap Pengik 

39 Lapis Perekat - Asp 

3.68 days 

1.4 days 

1.78 days 

0.5 days 

94.55 days 

94.55 days 

4.45 days 

2.36 days 

2.09 days 

0 days 

0 days 

0 days 

16.18 days 

0.5 days 

10.95 days 

3 days 

1 day 

1 day 

36 days 

36 days 

35.94 days 

37 days 

7 days 

6.99 days 

18.73 days 

1.73 days 

6.43 days 

0 days 

5 days 

4.99 days 

0.68 days 

0.4 days 

0.78 days 

-35.5 days 

58.55 days 

58.61 days 

-32.55 days 

-4.64 days 

-4.9 days 

-18.73 days 

-1.73 days 

-6.43 days 

16.18 days 

-4.5 days 

5.96 days 

3.16 days 

1.4 days 

1.6 days 

0.15 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

15.75 days 

0.07 days 

10.95 days 

0.52 days 

0 days 

0.17 days 

0.35 days 

0 days 

0 days 

0.02 days 

0 days 

0.02 days 

0 days 

0 days 

0 days 

0.43 days 

0.43 days 

0 days 

86% 

100% 

90% 

30% 

100% 

100% 

99% 

100% 

99% 

100% 

100% 

100% 

97% 

14% 

100% 

 
Pekerja[0.47],M 

Pekerja[0.22],Mandor[0.01],Excavator[0.62],D 

Pekerja[0.12],Mandor[0.0 

 
 
 

Pekerja[0.7],Mandor 

Pekerja[0.31] 

Sewa 

Pasa 

Bong 

40 Lapis Penetrasi Mac 4.73 days 

41 DIVISI 7. STRUKTUR 217.6 days 

9 days 

2.82 days 

-4.27 days 

214.78 days 

4.73 days 

217.6 days 

0 days 

0 days 

100% 

100% 

42 Beton struktur fc’ 30 44.24 days 5.59 days 38.65 days 44.24 days 0 days 100% 

43 Baja Tulangan Polo 173.36 days 4 days 169.36 days 173.36 days 0 days 100% 

44 Joint Sealent ( aspa 

45 Cat Anti Karat 

46 Expansion Cap ( pv 

0 days 

0 days 

0 days 

4 days 

4 days 

6 days 

-4 days 

-4 days 

-6 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 
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ID Task Name 

 
47 Polytene 125 mikro 

48 Curing Compound 

49 Concrete Cutting 

50 Sewa bekisting 

51 Pasang bekisting 

52 Bongkar bekisting 

53 

54 

55 

56 

57 

58 

59 

60 

61 

Work  

 
0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

Baseline 

 
0 days 

4.91 days 

0.97 days 

13 days 

8.11 days 

8.03 days 

1 day 

8 days 

8 days 

8 days 

8 days 

2 days 

10 days 

8 days 

8 days 

Variance 

 
0 days 

-4.91 days 

-0.97 days 

-13 days 

-8.11 days 

-8.03 days 

-1 day 

-8 days 

-8 days 

-8 days 

-8 days 

-2 days 

-10 days 

-8 days 

-8 days 

Actual  

 
0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

Remaining 

 
0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

% W. Comp. 

 
100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

100% 

20 December 202 
6 8 10    12     14    16     18    20     22    24     26  28    30 2 4 
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20 January 2021 February 2021 
6 8 10 12 14 16 18 20 22 24 26 28    30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29    31 2 4 6 8 10 12 14 16 18 20 

 
 
 
 

Sewa Rambu Peringatan dengan Kata-Kata[Rp200,000],Sewa Rambu Peringatan Pekerjaan di Jalan[2 Buah],Sewa Traffic Cone[4 Buah],Pita Pengaman [4 Buah],Sew 

Pekerja[2],Mandor 

 
 

Sewa Topi pelindung (Safety helmet)[10 Buah],Pelindung pernafasan dan mulut (Masker)[2 Box],Sarung tangan (Safety gloves)[10 Psg],Sewa Sepatu keselamatan (S 

Peralatan P3K (Kotak P3K;Obat Luk a; Perban; Dll)[1 Ls] 

 
44.32],Pasir[72],Concrete Mixer[60.14],Pekerja[12.87],Mandor[1.07],Tukang Batu[12.87] 

 
],Mandor[0.23],Concrete Cutter[Rp68,745],Jack Hammer + Compressor[15.06],Dump Truck[2.43] 

],Dumptruck[4.13] 

0.03],Dump Truck[1.79],Excavator[0.07],Mototr Grader[0.03],Vibrator Roller[0.06],Water Tank Truck[0.5] 
 

Pasir Kasar[8.08 M3],Pasir Halus[47.96 M3],Aspal[7,937.9 Kg],Wheel Loader[0.75],AMP[1.72],Genset[1.72],Dump Truck[14.43],ASPHALT FINISHER[3.3 Unit],Tandem 

 
or[0.09],Agregat A[208.06],Wheel Loader[1.41],Dump Truck 6 - 8 M3[52.2],Motor Grader[0],Vibratory Roller[2.1] 

31],Mandor[0.04],Agregat B[240.3],Wheel Loader[1.63],Dump Truck[61.05],Motor Grader[0.26],Vibratory Roller[1.83] 

wa bekisting[1,260 m'] 

sang bekisting[1,260 m'] 

ngkar bekisting[1,260 m'] 
 

Pekerja[0.05],Mandor[0.02],Aspal Emulsi CSS-1 [58.37 Liter],Asphalt Distributor[0.01],Air Compressor[0.02] 

Pekerja[1.46],Mandor[0.73],Aspal Emulsi[1,569.41],Asphalt Distributor[0.18],Air Compressor[0.92],Power Broom[0.73] 

Pekerja[4.3],Mandor[0.43],Agregat Kasar[5.33],Agregat Pengunci[1.66],Agregat Penutup[0.93],Dump Truck[0.75],Tandem Roller[0.21],Asphalt Distributor[0.07],Aspal[382.64 Kg],K 
 

Semen[174,834.43],Pasir Pasang / Beton[288.19],Agregat Kasar[407.23],Air[96,037.2],platizier[524.51],Concrete Mixing Plant[25.3],Truck Mixer[177.21],Concrete Vibrator[151.8],Water 

Pekerja[13.01],Tukang Batu[4.33],Mandor[4.33],Baja Tulangan Polos BjTP 280[8,170.16 Kg],Kawat Beton[158.64 M3] 

Joint Sealent ( aspal )[132.38] 

Cat Anti Karat[8.37] 

Expansion Cap ( pvc + solatip )[149.94] 
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20 January 2021 February 2021 
6 8 10 12 14 16 18 20 22 24 26 28 30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31 2 4 6 8 10 12 14 16 18 20 

 Polytene 125 mikron[496.13]   
 

Curing Compound[529.2]  

Concrete Cutting[504] 

 Sewa bekisting1[1,260] 

Pasang bekisting1[1,260] 

Bongkar bekisting1[1,260] 
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Summary Duration-only Progress 
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External Tasks Manual Summary 

External Milestone Start-only 

Page 4 
 

March 2021 
20     22    24   26    28 2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 

April 2021 
1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 

May 2021 
1 3 5 7 

  
 
 
 

],Sewa Lampu Sementara[2 Buah],Sewa Tongkat Pengatur Lalu Lintas (Warning Light Stick)[4 Buah],Sewa Lampu ... 

 
 
 

tan (Safety shoes)[10 Psg],Rompi keselamatan (Safety vest)[10 Buah] 

 
 
 
 
 
 
 
 

 
dem Roller[21.49],P. Tyre Roller[2.04],Pekerja[17.19],Mandor[1.72] 

 
 
 
 
 
 
 
 
 

 
Kg],Kayu bakar [0.24],Wheel Loader[0.03] 

Water Tank Truck[19.25],Pekerja[4.74],Mandor[0.79] 
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 March 2021 April 2021 May 2021 
20 22 24 26 28 2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 1 3 5 7 

    

 

 
Task 

     
Inactive Milestone 

    
Finish-only 

        

 Split      Inactive Summary     External Tasks  
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Summary 
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Progress 
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    Start-only              

Page 6 

 

 June 2021 July 2021 
7 9 11 13 15 17 19 21 23 25 27 29 31 2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 2 4 6 8 10 12 14 16 18 20 22 

    

 

 
Task 

      
Inactive Milestone 

    
Finish-only 

        

 Split       Inactive Summary     External Tasks  
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i 

j 

j 

j 

November 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

      1 

       

2 3 4 5 6 7 8 

       

9 10 11 12 13 14 15 

 Sosialisasi dan Promosi   Peralatan, 36 days   

1 day?   Tenaga, 36 days   

1 day?  Alat Pelindung Ker ja (APK) dan Alat Pelindung Diri (APD), 36 days  

1 day?  Fas ilitas sarana kesehatan, 36 d ays  

1 day?  Galian B asa (menggunakan alat bera t), 7 days  

16 17 18 19 20 21 22 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

Galian Biasa (menggun akan alat berat), 7 days  Pasa ngan Batu dengan Mortar, 7 days  

23 24 25 26 27 28 29 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

Pasangan Batu den gan Mortar, 7 days Timbunan Kembali Dari H   Galian Perkerasan Beraspa l tanpa Cold Milling Machin 

30       

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

j 

j 

December 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

 1 2 3 4 5 6 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

7 8 9 10 11 12 13 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

   Joint Sealent ( aspal ), 1 Lapis Resap Pengikat - A Latasir Kelas B (SS-B), 5 days 

    Lapis Penetrasi Macadam Lapis Perekat - Aspa l Cair/Emulsi, 5 days 

14 15 16 17 18 19 20 

 Peralatan, 36 days      

 Tenaga, 36 days  

Alat Pelindung Kerj a (APK) dan Alat Pelindung Di ri (APD), 36 days 

Fas ilitas sarana kesehatan, 36 d ays 

L atasir Kelas B (SS-B), 5 days  

Lapis Perekat - Aspal Cair/Emulsi, 5 days 

21 22 23 24 25 26 27 

       

28 29 30 31    
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C. Hasil Output Penambahan Jam Kerja (Lembur) 3 Jam 
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ID Resource Name % Comp. Work Overtime Baseline Variance Actual Remaining  
1 TANDEM ROLLER 6-8 T 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

2 WATER TANKER 3000- 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

3 ASPHALT FINISHER 100% 4.3 Unit 0 days 4.3 Unit 0 Unit 4.3 Unit 0 Unit 

4 TIRE ROLLER 8-10 T. 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

5 ASPHALT SPRAYER 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 
6 COMPRESSOR 4000-65 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

7 EXCAVATOR 80 - 140 M 100% 1 Unit 0 days 1 Unit 0 Unit 1 Unit 0 Unit 

8 Test Kuat Tarik Besi 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

9 Ekstraksi Aspal 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

10 Uji Kuat Tekan Beton 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

11 Papan nama proyek 100% 2 Set 0 days 2 Set 0 Set 2 Set 0 Set 

12 Demobilisasi 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

13 Sewa Rambu Peringatan 0%  0 days  0   

14 Sewa Rambu Peringatan 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

15 Sewa Traffic Cone 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

16 Pita Pengaman 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

17 Sewa Lampu Sementara 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

18 Sewa Tongkat Pengatur 100% 4 Buah 0 days 4 Buah 0 Buah 4 Buah 0 Buah 

19 Sewa Lampu Putar (Rota 100% 2 Buah 0 days 2 Buah 0 Buah 2 Buah 0 Buah 

20 Sewa Peralatan komunik 100% 1 Set 0 days 1 Set 0 Set 1 Set 0 Set 

21 Alat Bantu 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

22 Pekerja (Flagman) 0% 0 days 0 days 0 days 0 days 0 days 0 days 

23 Koordinator / Pengatur 0% 0 days 0 days 0 days 0 days 0 days 0 days 

24 Spanduk (Banner) 100% 2 Lbr 0 days 2 Lbr 0 Lbr 2 Lbr 0 Lbr 

25 Papan Informasi K3 100% 1 Buah 0 days 1 Buah 0 Buah 1 Buah 0 Buah 

26 Sewa Topi pelindung (Sa 100% 10 Buah 0 days 10 Buah 0 Buah 10 Buah 0 Buah 

27 Pelindung pernafasan da 100% 2 Box 0 days 2 Box 0 Box 2 Box 0 Box 
28 Sarung tangan (Safety gl 100% 10 Psg 0 days 10 Psg 0 Psg 10 Psg 0 Psg 

29 Sewa Sepatu keselamata 100% 10 Psg 0 days 10 Psg 0 Psg 10 Psg 0 Psg 

30 Rompi keselamatan (Saf 100% 10 Buah 0 days 10 Buah 0 Buah 10 Buah 0 Buah 

31 Peralatan P3K (Kotak P3 100% 1 LS 0 days 1 LS 0 LS 1 LS 0 LS 

32 Pekerja 100% 408.58 days 4.13 days 408 days 0.58 days 408 days 0.58 days 

33 Tukang Batu 100% 42.13 days 0.75 days 42.13 days 0 days 42.13 days 0 days 

34 Mandor 99% 99.21 days 4.13 days 98.21 days 1 day 98.21 days 1 day 

35 Batu 100% 179.71 0 days 0 179.71 179.71 0 

36 Semen 100% 209,578.75 0 days 0 209,578.75 209,578.75 0 

37 Pasir 100% 72 0 days 0 72 72 0 

38 Concrete Mixer 100% 60.14 0 days 0 60.14 60.14 0 

39 Concrete Cutter 0%  0 days  0   

40 Jack Hammer + Compre 100% 15.06 0 days 0 15.06 15.06 0 

41 Dump Truck 100% 80.45 0 days 0 80.45 80.45 0 

42 Excavator 100% 0.69 0 days 0 0.69 0.69 0 

43 Dumptruck 100% 4.13 0 days 0 4.13 4.13 0 

44 Mototr Grader 100% 0.03 0 days 0 0.03 0.03 0 

45 Vibrator Roller 100% 0.06 0 days 0 0.06 0.06 0 

46 Water Tank Truck 100% 19.75 0 days 0 19.75 19.75 0 

47 Pasir Kasar 100% 8.08 M3 0 days 8.08 M3 0 M3 8.08 M3 0 M3 

48 Pasir Halus 100% 47.96 M3 0 days 47.96 M3 0 M3 47.96 M3 0 M3 

49 Aspal 100% 8,320.54 Kg 0 days 8,320.54 Kg 0 Kg 8,320.54 Kg 0 Kg 

50 Wheel Loader 100% 3.82 0 days 0 3.82 3.82 0 

51 AMP 100% 1.72 0 days 0 1.72 1.72 0 

52 Genset 100% 1.72 0 days 0 1.72 1.72 0 

53 Dump Truck 0% 0 0 days 0 0 0 0 

54 Asphalt Finisher 0% 0 0 days 0 0 0 0 

55 Tandem Roller 100% 21.7 0 days 0 21.7 21.7 0 

56 P. Tyre Roller 100% 2.04 0 days 0 2.04 2.04 0 

57 Agregat A 100% 208.06 0 days 0 208.06 208.06 0 

58 Agregat B 100% 240.3 0 days 0 240.3 240.3 0 

59 Wheel Loader 0% 0 0 days 0 0 0 0 

60 Dump Truck 6 - 8 M3 100% 52.2 0 days 0 52.2 52.2 0 

61 Motor Grader 100% 0.26 0 days 0 0.26 0.26 0 

62 Vibratory Roller 100% 3.93 0 days 0 3.93 3.93 0 

63 Sewa bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 

64 Pasang bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 

65 Bongkar bekisting 100% 1,260 m' 0 days 1,260 m' 0 m' 1,260 m' 0 m' 
66 Aspal Emulsi CSS-1 100% 58.37 Liter 0 days 58.37 Liter 0 Liter 58.37 Liter 0 Liter 
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ID Resource Name % Comp. Work Overtime Baseline Variance Actual Remaining  
67 Asphalt Distributor 100% 0.26 0 days 0 0.26 0.26 0 

68 Air Compressor 100% 0.94 0 days 0 0.94 0.94 0 

69 Aspal Emulsi 100% 1,569.41 0 days 0 1,569.41 1,569.41 0 

70 Power Broom 100% 0.73 0 days 0 0.73 0.73 0 

71 Agregat Kasar 100% 412.56 0 days 0 412.56 412.56 0 
72 Agregat Pengunci 100% 1.66 0 days 0 1.66 1.66 0 

73 Agregat Penutup 100% 0.93 0 days 0 0.93 0.93 0 

74 Aspal 0% 0 0 days 0 0 0 0 

75 Kayu bakar 100% 0.24 0 days 0 0.24 0.24 0 

76 Pasir Pasang / Beton 100% 288.19 0 days 0 288.19 288.19 0 

77 Air 100% 96,037.2 0 days 0 96,037.2 96,037.2 0 

78 platizier 100% 524.51 0 days 0 524.51 524.51 0 

79 Concrete Mixing Plant 100% 25.3 0 days 0 25.3 25.3 0 

80 Truck Mixer 100% 177.21 0 days 0 177.21 177.21 0 

81 Concrete Vibrator 100% 151.8 0 days 0 151.8 151.8 0 

82 Water Tank Truck 0% 0 0 days 0 0 0 0 

83 Baja Tulangan Polos BjT 100% 8,170.16 Kg 0 days 8,170.16 Kg 0 Kg 8,170.16 Kg 0 Kg 

84 Kawat Beton 100% 158.64 M3 0 days 158.64 M3 0 M3 158.64 M3 0 M3 

85 Joint Sealent ( aspal ) 100% 132.38 0 days 0 132.38 132.38 0 

86 Cat Anti Karat 100% 8.37 0 days 0 8.37 8.37 0 

87 Expansion Cap ( pvc + so 100% 149.94 0 days 0 149.94 149.94 0 

88 Polytene 125 mikron 100% 496.13 0 days 0 496.13 496.13 0 

89 Curing Compound 100% 529.2 0 days 0 529.2 529.2 0 

90 Concrete Cutting 100% 504 0 days 0 504 504 0 

91 Sewa bekisting1 100% 1,260 0 days 0 1,260 1,260 0 

92 Pasang bekisting1 100% 1,260 0 days 0 1,260 1,260 0 
93 Bongkar bekisting1 100% 1,260 0 days 0 1,260 1,260 0 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Page 1  

ID Task Name Work Baseline Variance Actual Remaining % W. Comp. Nov 9, '20 Nov 16, '20 
 

1 PENINGKATAN JALAN K 549.92 days 

 

0 days 

 

549.92 days 548.34 days 

 

1.58 days 
S M 

99% 
T W T F S S M T W T F 

2 UMUM 

3 Mobilisasi 

108 days 

0 days 

0 days 

0 days 

108 days 

0 days 

108 days 

0 days 

0 days 

0 days 

100% 

100% 

16 Manajemen dan Ke 108 days 0 days 108 days 108 days 0 days 100% 

17 Peralatan 

18 Tenaga 

19 Keselamatan dan 

0 days 

108 days 

0 days 

0 days 

0 days 

0 days 

0 days 

108 days 

0 days 

0 days 

108 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 

20 Sosialisasi dan P 0 days 0 days 0 days 0 days 0 days 100% Spanduk (Banner)[2 Lbr],Papan Informasi K3[1 Buah] 

21 Alat Pelindung K 

22 Fasilitas sarana 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

23 DIVISI 2. DRAINASE 

24 Pasangan Batu den 

104.86 days 

104.86 days 

0 days 

0 days 

104.86 days 104.86 days 

104.86 days  104.86 days 

0 days 

0 days 

100% 

100% 

25 DIVISI 3. PEKERJAA 

26 Galian Perkerasan 

27 Galian Biasa (meng 

28 Timbunan Kembali 

29 DIVISI 4. PEKERJAA 

30 Latasir Kelas B (SS 

31 DIVISI 5. PEKERASA 

32 Lapis Pondasi Agre 

33 Lapis Pondasi Agre 

34 Sewa bekisting 

35 Pasang bekisting 

36 Bongkar bekisting 

37 DIVISI 6. PERKERAS 

38 Lapis Resap Pengik 

39 Lapis Perekat - Asp 

4.05 days 

1.4 days 

1.9 days 

0.75 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

16.43 days 

0.75 days 

10.95 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

4.05 days 

1.4 days 

1.9 days 

0.75 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

16.43 days 

0.75 days 

10.95 days 

3.16 days 

1.4 days 

1.6 days 

0.15 days 

94.55 days 

94.55 days 

4.43 days 

2.36 days 

2.07 days 

0 days 

0 days 

0 days 

15.75 days 

0.07 days 

10.95 days 

0.9 days 

0 days 

0.3 days 

0.6 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0.68 days 

0.68 days 

0 days 

78% 

100% 

84% 

20% 

100% 

100% 

100% 

99% 

100% 

100% 

100% 

100% 

96% 

9% 

100% 

 

 
Pekerja[0.22],Man 

40 Lapis Penetrasi Mac 4.73 days 

41 DIVISI 7. STRUKTUR 217.6 days 

0 days 

0 days 

4.73 days 

217.6 days 

4.73 days 

217.6 days 

0 days 

0 days 

100% 

100% 

42 Beton struktur fc’ 30 44.24 days 0 days 44.24 days 44.24 days 0 days 100% 

43 Baja Tulangan Polo 173.36 days 0 days 173.36 days 173.36 days 0 days 100% 

44 Joint Sealent ( aspa 

45 Cat Anti Karat 

46 Expansion Cap ( pv 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

0 days 

100% 

100% 

100% 
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ID Task Name Work Baseline Variance Actual Remaining % W. Comp.  
S 

Nov 9, '20 Nov 16, '20 
M T W T F S S M T W T F  

47 Polytene 125 mikro 0 days 0 days 0 days 0 days 0 days 100%    

48 Curing Compound 0 days 0 days 0 days 0 days 0 days 100% 

49 Concrete Cutting 0 days 0 days 0 days 0 days 0 days 100% 

50 Sewa bekisting 0 days 0 days 0 days 0 days 0 days 100% 

51 Pasang bekisting 0 days 0 days 0 days 0 days 0 days 100% 

52 Bongkar bekisting 0 days 0 days 0 days 0 days 0 days 100% 

 

 
Task 

  
Inactive Milestone 

 
Finish-only 

  

 Split   Inactive Summary  External Tasks 
 

  

 
Project: Project 3. 
Date: 7/22/2021 

Milestone 

Summary 

 

  Manual Task 

Duration-only 

 External Milestone 

Progress 

  

 Project Summary   Manual Summary Rollup  Deadline 
 

  

 External Tasks   Manual Summary     

 External Milestone 
 

  Start-only     

Page 2 

 

Page 3  

Nov 23, '20 Nov 30, '20 Dec 7, '20 Dec 14, '20 Dec 21, '20 
S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T 

 
 
 
 

Sewa Rambu Peringatan dengan Kata-Kata[ 

Pekerja[2],Mandor 

 
 

Sewa Topi pelindung (Safety helmet)[10 Bua 

Peralatan P3K (Kotak P3K;Obat Luk a; Perb 

 

Batu[179.71],Semen[34,744.32],Pasir[72],Concrete Mixer[60.14],Pekerja[12.87],Mandor[1.07],Tukang Batu[12.87] 
 

Pekerja[0.47],Mandor[0.23],Concrete Cutter[Rp68,745],Jack Hammer + Compressor[15.06],Dump Truck[2.43] 

andor[0.01],Excavator[0.62],Dumptruck[4.13] 

Pekerja[0.12],Mandor[0.03],Dump Truck[1.79],Excavator[0.07],Mototr Grader[0.03],Vibrator Roller[0.06],Water Tank Truck[0.5] 
 

Pasir Kasar[8.08 M3],Pasir Halus[47.96 M3], 
 

Pekerja[0.7],Mandor[0.09],Agregat A[208.06],Wheel Loader[1.41],Dump Truck 6 - 8 M3[52.2],Motor Grader[0],Vibratory Roller[2.1] 

Pekerja[0.31],Mandor[0.04],Agregat B[240.3],Wheel Loader[1.63],Dump Truck[61.05],Motor Grader[0.26],Vibratory Roller[1.83] 

Sewa bekisting[1,260 m'] 

Pasang bekisting[1,260 m'] 

Bongkar bekisting[1,260 m'] 
 

Pekerja[0.05],Mandor[0.02],Aspal Emulsi CSS-1 [58.37 Liter],Asphalt Dis 

Pekerja[1.46],Mandor[0.73],Aspal Emulsi[1,5 

Pekerja[4.3],Mandor[0.43],Agregat Kasar[5.33],Agregat Pengunci[1.66],A 
 

Semen[174,834.43],Pasir Pasang / Beton[288.19],Agregat Kasar[407.23],Air[96,037.2 

Pekerja[13.01],Tukang Batu[4.33],Mandor[4.33],Baja Tulangan Polos BjTP 280[8,170.16 Kg],Kaw 

Joint Sealent ( aspal )[132.38] 

Cat Anti Karat[8.37] 

Expansion Cap ( pvc + solatip )[149.94] 
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Nov 23, '20 
S S M T W T F S S 

Nov 30, '20 
M T W T F S S 

Dec 7, '20 
M T W T F S S 

Polytene 125 mikron[496.13] 

Curing Compound[529.2] 

Dec 14, '20 
M T W T F S S 

Dec 21, '20 
M T W T 

Concrete Cutting[504] 

Sewa bekisting1[1,260] 

Pasang bekisting1[1,260] 

Bongkar bekisting1[1,260] 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Project: Project 3. 
Date: 7/22/2021 

Task 

Split 

Milestone 

Summary 

Project Summary 

External Tasks 

External Milestone 

Inactive Milestone 

Inactive Summary 

Manual Task 

Duration-only 

Manual Summary Rollup 

Manual Summary 

Start-only 

Finish-only 

External Tasks 

External Milestone 

Progress 

Deadline 

 
F S S 

Dec 28, '20 
M T W T F S S 

Jan 4, '21 
M T W T F S S 

Jan 11, '21 
M T W T F S S 

Jan 18, '21 
M T W T F S S 

Jan 25, '21 
M T W 

 
 
 
 

[Rp200,000],Sewa Rambu Peringatan Pekerjaan di Jalan[2 Buah],Sewa Traffic Cone[4 Buah],Pita Pengaman [4 Buah],Sewa Lampu Sementara[2 Buah],Sewa Tongkat Pengatur Lalu Lintas (Warn 

 
 
 

ah],Pelindung pernafasan dan mulut (Masker)[2 Box],Sarung tangan (Safety gloves)[10 Psg],Sewa Sepatu keselamatan (Safety shoes)[10 Psg],Rompi keselamatan (Safety vest)[10 Buah] 

ban; Dll)[1 Ls] 

 
 
 
 
 
 
 

,Aspal[7,937.9 Kg],Wheel Loader[0.75],AMP[1.72],Genset[1.72],Dump Truck[14.43],ASPHALT FINISHER[3.3 Unit],Tandem Roller[21.49],P. Tyre Roller[2.04],Pekerja[17.19],Mandor[1.72] 

 
 
 
 
 
 
 
 

stributor[0.01],Air Compressor[0.02] 

569.41],Asphalt Distributor[0.18],Air Compressor[0.92],Power Broom[0.73] 

Agregat Penutup[0.93],Dump Truck[0.75],Tandem Roller[0.21],Asphalt Distributor[0.07],Aspal[382.64 Kg],Kayu bakar [0.24],Wheel Loader[0.03] 

 
2],platizier[524.51],Concrete Mixing Plant[25.3],Truck Mixer[177.21],Concrete Vibrator[151.8],Water Tank Truck[19.25],Pekerja[4.74],Mandor[0.79] 

wat Beton[158.64 M3] 
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Split 
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 Dec 28, '20 Jan 4, '21 Jan 11, '21 Jan 18, '21 Jan 25, '21 
F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W 

      

 

 
Task 

    
Inactive Milestone 

   
Finish-only 

       

 Split     Inactive Summary    External Tasks  
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Date: 7/22/2021 

Milestone 

Summary 

 

    Manual Task 

Duration-only 

   External Milestone 

Progress 

       

 Project Summary     Manual Summary Rollup    Deadline  
 

      

 External Tasks     Manual Summary            

 External Milestone 
 

    Start-only            

Page 6 

 



121 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

i 

j 

j 

j 

November 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

      1 

       

2 3 4 5 6 7 8 

       

9 10 11 12 13 14 15 

 Sosialisasi dan Promosi   Peralatan, 36 days   

  Tenaga, 36 days   

 Alat Pelindung Ker ja (APK) dan Alat Pelindung Diri (APD), 36 days  

 Fas ilitas sarana kesehatan, 36 d ays  

 Galian B asa (menggunakan alat bera t), 7 days  

16 17 18 19 20 21 22 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

Galian Biasa (menggun akan alat berat), 7 days  Pasa ngan Batu dengan Mortar, 7 days  

23 24 25 26 27 28 29 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

Pasangan Batu den gan Mortar, 7 days Timbunan Kembali Dari H   Galian Perkerasan Beraspa l tanpa Cold Milling Machin 

30       

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

 

j 

j 

December 2020 
Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

 1 2 3 4 5 6 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

7 8 9 10 11 12 13 

   Peralatan, 36 days    

   Tenaga, 36 days    

  Alat Pelindung Ker a (APK) dan Alat Pelindung Diri (APD), 36 days   

  Fas ilitas sarana kesehatan, 36 d ays   

   Joint Sealent ( aspal ), 1 Lapis Resap Pengikat - A Latasir Kelas B (SS-B), 5 days 

    Lapis Penetrasi Macadam Lapis Perekat - Aspa l Cair/Emulsi, 5 days 

14 15 16 17 18 19 20 

 Peralatan, 36 days      

 Tenaga, 36 days  

Alat Pelindung Kerj a (APK) dan Alat Pelindung Di ri (APD), 36 days 

Fas ilitas sarana kesehatan, 36 d ays 

L atasir Kelas B (SS-B), 5 days  

Lapis Perekat - Aspal Cair/Emulsi, 5 days 

21 22 23 24 25 26 27 

       

28 29 30 31    
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Lampiran 7.  

DOKUMENTASI PROYEK 

PROYEK PENINGKATAN JALAN KALIGANGSA WETAN- 

RANDUSANGA WETAN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Pembersihan Lahan Dengan Alat Bulldozer 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2. Pemadatan Tanah Dengan Alat Vibrator Roller  
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Gambar 3. Proses Penaruhan Hamparan Plastik 
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